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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. TheTechnical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, theTechnical Support groupworkswithProductEngineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at
the following URL:

www.symantec.com/business/support/index.jsp

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/contact_techsupp_static.jsp

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer onwhich theproblemoccurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level
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■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If yourSymantecproduct requires registrationor a licensekey, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals

http://www.symantec.com/business/support/
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Support agreement resources
If youwant to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

Documentation
Product guides are available on the media in PDF format. Make sure that you are
using the current version of the documentation. The document version appears
on page 2 of each guide. The latest product documentation is available on the
Symantec website.

https://sort.symantec.com/documents

Your feedback on product documentation is important to us. Send suggestions
for improvements and reports on errors or omissions. Include the title and
document version (located on the second page), and chapter and section titles of
the text on which you are reporting. Send feedback to:

doc_feedback@symantec.com

For information regarding the latest HOWTO articles, documentation updates,
or to ask a question regarding product documentation, visit the Storage and
Clustering Documentation forum on Symantec Connect.

https://www-secure.symantec.com/connect/storage-management/
forums/storage-and-clustering-documentation

About Symantec Connect
Symantec Connect is the peer-to-peer technical community site for Symantec’s
enterprise customers. Participants can connect and share informationwith other
product users, including creating forum posts, articles, videos, downloads, blogs
and suggesting ideas, as well as interact with Symantec product teams and
Technical Support. Content is rated by the community, and members receive
reward points for their contributions.

http://www.symantec.com/connect/storage-management
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Introducing the Veritas
High Availability Agent for
SAP NetWeaver

This chapter includes the following topics:

■ About the High Availability agent for SAP NetWeaver

■ What’s new in this release

■ Supported software

■ How the agent makes SAP NetWeaver highly available

■ Agent functions

■ Typical SAP server configuration in a VCS cluster

■ Setting up SAP NetWeaver in a VCS cluster

About the High Availability agent for SAP NetWeaver
Veritas High Availability agents monitor specific resources within an enterprise
application, determine the status of these resources, and start or stop them
according to external events.

The Veritas agent for SAP NetWeaver provides high availability for SAP R/3 and
SAP NetWeaver in a clustered environment.

It is designed to support a wide range of SAP environments, including the
traditional basis architecture and the SAP J2EE Web Application server
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architecture (NetWeaver). The agent also support Standalone Enqueue and
Enqueue Replication servers in a distributed SAP installation.

The agent for SAPNetWeaver bringsSAP instances online,monitors the instances,
and bring the instances offline. The agent monitors the system processes and
server states, and can shut down the instance in case of a failure.

The agent for SAP NetWeaver supports the following SAP instance types:

■ Central instance

■ Dialog instance

■ Standalone Enqueue server

■ Enqueue Replication server

What’s new in this release
The enhancements in this release of the agent for SAP NetWeaver are as follows:

■ Added support for SAP Master Data Management (MDM) Server components.

Supported software
For information on the software versions that the agent for SAP NetWeaver
supports, see the Symantec Operations Readiness Tools (SORT) site:
https://sort.symantec.com/agents.

How the agentmakesSAPNetWeaver highly available
The Veritas agent for SAP NetWeaver continuously monitors the SAP instance
processes to verify that they function properly.

The agent provides the following levels of application monitoring:

■ Primary or Basic monitoring
This mode has Process check and Health check monitoring options. With the
default Process check option, the agent verifies that the SAP instance processes
are present in theprocess table. Process check cannot detectwhether processes
are in hung or stopped states.

■ Secondary or Detail monitoring
In this mode, the agent runs a utility to verify the status of the SAP instance.
The agent detects application failure if the monitoring routine reports an
improper function of the SAP instance processes.When this application failure
occurs, the SAP instance service group fails over to another node in the cluster.

Introducing the Veritas High Availability Agent for SAP NetWeaver
What’s new in this release
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Thus, the agent ensures high availability for SAP instances.

Agent functions
The agent consists of resource type declarations and agent executables. The agent
executables are organized into online, offline, monitor, and clean functions.

Online
The online function performs the following tasks:

■ Validates the values of the agent attributes required to bring the SAP instance
online.

■ Performs a preliminary check to ensure that the SAP instance is not running
already on the specified node in the cluster.

■ Starts the SAP Windows service SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■ Starts the SAP instance using the startsap.exe utility.

■ Ensures that the instance is initialized successfully.

Offline
The offline function performs the following tasks:

■ Validates the values of the agent attributes required to bring the SAP instance
offline.

■ Performs a preliminary check to ensure that the SAP instance is not already
offline.

■ Stops the SAP instance using the stopsap.exe utility.

■ Stops the SAP Windows service. SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■ Kills any remaining SAP instance processes to ensure that the instance
processes are removed completely.

Monitor
The monitor function performs the following tasks:

■ Validates the values of the agent attributes required to monitor the SAP
instance.

15Introducing the Veritas High Availability Agent for SAP NetWeaver
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■ Performs a first-level monitor check as follows:

■ The function verifies that the SAP Windows service SAPSAPSID_InstID is
running, where InstID is the last two characters of the InstName attribute.

■ Verifies that all processes that the ProcMon attribute lists are running.

■ If the value of SecondLevelMonitor attribute is greater than 0, the monitor
function performs a more thorough check of the SAP instance as follows:

■ For an ABAP Central or Dialog instance, the function uses the sapinfo.exe
utility.
To use second-level monitoring for the ABAP configuration, download the
rfcsdk file for the sapinfo.exe utility. Unzip this file and place the contents
on shared storage that is accessible by all the nodes in the cluster.

■ For a JavaCentral orDialog instance, the functionuses the jcmon.exeutility.

■ For an Enqueue or Enqueue Replication server instance, the function uses
the ensmon.exe utility.

■ If the MonitorProgram attribute specifies a custom monitor program, the
monitor function executes the specified program.
See “Executing a custom monitor program” on page 88.

Clean
In case of a fault event or an unsuccessful attempt to bring a resource online or
offline, the clean function removes any remaining SAP instance processes. The
clean function performs the following tasks:

■ Uses SAP’s sapsrvkill.exe utility to stop all processes of the particular SAP
instance.

■ Stops SAPSAPSID_InstID, the SAP Windows service for the instance.

■ The clean function identifies and kills any remaining SAP instance processes
using the unique combination of the SAPSID attribute and InstID, that is the
last two characters of the InstName attribute. All these processes must also
belong to the SAPServiceSAPSID or sapsidadm user.

Typical SAP server configuration in a VCS cluster
A typical SAP server configuration in a VCS cluster has the following
characteristics:

■ VCS is installed and configured in a two-node cluster.

Introducing the Veritas High Availability Agent for SAP NetWeaver
Typical SAP server configuration in a VCS cluster
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■ The SAP NetWeaver instance binaries are installed locally on both nodes or
on shared disks.

■ The Veritas agent for SAP NetWeaver is installed on the both nodes.

■ The drive:\usr\sap directory is shared with name sapmnt.

Figure 1-1 depicts a configuration where SAP server instance binaries and SYS
are installed completely on shared disks.

Public Network

Shared disks / diskgroups

VCS Private Network

SAP instance binaries and
SYS on shared disks

Node 1
Node 2
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Figure 1-2 depicts a configuration where SAP server instance binaries are
installed locally on each node and SYS is installed on shared disks.

Public Network

Shared disks / diskgroups

VCS Private Network

Node 1 Node 2

SAP instance binaries

SAP instance binaries

SYS on shared disks

Setting up SAP NetWeaver in a VCS cluster
Follow the steps below to set up SAP NetWeaver in a cluster:

■ Set up a VCS cluster.
Refer to Veritas Storage Foundation™ and High Availability Solutions
Installation and Upgrade Guide for more information on installing and
configuring VCS.

■ Install and configure SAP NetWeaver for High Availability.

■ Install the Veritas High Availability agent for SAP NetWeaver.
See “Installing the VCS agent for SAP NetWeaver” on page 77.

■ Configure the service groups for SAP NetWeaver.
See “About configuring service groups for SAP NetWeaver” on page 91.

Introducing the Veritas High Availability Agent for SAP NetWeaver
Setting up SAP NetWeaver in a VCS cluster
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Installing and configuring
the SAP NetWeaver for high
availability

This chapter includes the following topics:

■ About SAP NetWeaver

■ Uniquely identifying SAP server instances

■ Monitoring an SAP instance

■ About installing SAP NetWeaver for high availability

■ About configuring SAP NetWeaver for high availability

■ Setting up SAP systems for clustering

■ Setting up a pre-installed SAP R/3 system

■ Fresh SAP installation: Installing an SAP ABAP system

■ Fresh SAP installation: Installing an SAP Java system

■ Fresh SAP installation: Installing a Java Add-In system (ABAP + Java)

■ Fresh SAP installation: Installing SAP MDM Server Components

■ Installing an SAP Enqueue Replication server

■ Clustering an SAP instance

■ Creating and adding domain groups and users

■ Creating and adding local groups and users
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■ Creating sapmnt and saploc share directories

■ Configuring the SAP systems on Windows Server 2008

About SAP NetWeaver
All SAP NetWeaver components (example, BI, XI, EP ) run on top of the SAP
NetWeaver Application Server.

The following SAP system installations are possible with SAP NetWeaver
Application Server (AS):

■ SAP NetWeaver Application Server ABAP (ABAP only)

■ SAP NetWeaver AS Java (Java only)

■ SAP NetWeaver Application Server Add-In (ABAP and Java)

■ SAP Netweaver Master Data Management Server

Depending on the SAPNetWeaver component to be installed, theWebApplication
Server type is determined. For example, SAP NetWeaver EP 6.0 requires a Java
stack, hence SAP NetWeaver AS Java (or Add-In) needs to be installed. SAP
NetWeaver XI 3.0 requires SAP NetWeaver AS Add-In.

SAP system components
An SAP application instance has multiple services or components which are
typically deployed across multiple servers.

SAP identifies the following services as critical to the application environment,
representing potential single points of failure:

■ Database Instance

■ Central Instance (DVEBMGSxx or JCxx)

■ Central Services Instance (SCSxx or ASCSxx)

■ Enqueue Replication Server (ERSxx)

■ Dialog Instance (Dxx or Jxx)

■ Windows sapmnt/saploc shares

■ Master Data Server (MDSxx)

■ Master Data Import Server (MDISxx)

■ Master Data Syndicate Server (MDSSxx)

■ Master Data Layout Server (MDLSxx)

Installing and configuring the SAP NetWeaver for high availability
About SAP NetWeaver

20



Where xx takes the value of an SAP Instance number ranging from 00 to 99.

SAP architecture
Table 2-1 lists the different SAP architectures and its components.

Table 2-1 SAP architecture

FunctionsServiceComponentArchitecture

■ Controls program that manages the
resources of the R/3 applications.

■ Balances assignment of the transaction
load to the work processes.

■ Manages buffers in main memory.

■ Manages connections with the
presentation level.

■ Organizes the communication processes.

ABAP DispatcherCentral Instance

Dialog Instance

SAP NetWeaver AS
ABAP

■ Acts as a service offered by a server and
requested by a client

■ Acts as a special program in charge of
some specific tasks.

ABAP Work
processes

■ Manages logical locks.

■ Ensures server synchronization.

ABAP Enqueue
Service

Central Services
Instance

■ Central service for cluster internal
communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher.

■ Keeps a list of application servers that can
be reached within the system.

ABAP Message
Service

Enables the lock table to be replicated on a
second server, the replication server.

ABAP Enqueue
Replication Service

Enqueue Replication
Instance

Receives client requests and forwards them
to the server processes accordingly.

Java DispatcherCentral InstanceSAP NetWeaver AS
Java

Processes the requests and holds the session
data.

JavaServerProcesses
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Table 2-1 SAP architecture (continued)

FunctionsServiceComponentArchitecture

The Software DeploymentManager (SDM) is
a toolwithwhichyou canmanage anddeploy
software packages (Software Deployment
Archives andSoftware ComponentArchives)
that you receive from SAP to the Web AS
Java.

SDM

Receives client requests and forwards them
to the server processes accordingly.

Java DispatcherDialog Instance

Processes the requests and holds the session
data.

JavaServerProcesses

■ Manages logical locks.

■ Ensures server synchronization.

JavaEnqueueServiceCentral Services
Instance

■ Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher.

■ Keeps a list of application servers that can
be reached within the system.

JavaMessage Service

Enables the lock table to be replicated on a
second server, the replication server.

Java Enqueue
Replication Service

Enqueue Replication
Instance

■ Controls program that manages the
resources of R/3 applications.

■ Balances the assignments of the
transaction load to the work processes.

■ Manages buffer in main memory.

■ Connects to the presentation level.

■ Organizes the communication processes.

ABAP DispatcherCentral Instance
(ABAP and Java)

SAP NetWeaver AS
Add-In

■ Acts as a service offered by a server and
requested by a client.

■ Manages the programs that handle
specific tasks.

ABAP Work
processes

■ Receives client requests and accordingly
forwards them to the server for further
processing.

Java Dispatcher

Installing and configuring the SAP NetWeaver for high availability
About SAP NetWeaver
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Table 2-1 SAP architecture (continued)

FunctionsServiceComponentArchitecture

■ Handles the client-server processes and
maintains the session data.

JavaServerProcesses

■ Manages the software packages received
from SAP and deploys them on Web AS
Java.

SDM

■ Controls the programs that manages the
resources of R/3 applications.

■ Balances assignment of the transaction
load to the work processes.

■ Manages buffer in main memory.

■ Connection with the presentation level.

■ Organizes the communication processes.

ABAP DispatcherDialog Instance
(ABAP and Java)

■ Acts as a service offered by a server and
requested by a client.

■ Acts as a special program in charge of
some specific tasks.

ABAP Work
processes

Receives client requests and forwards them
to the server processes accordingly.

Java Dispatcher

Processes the requests and holds the session
data.

JavaServerProcesses

■ Manages logical locks

■ Ensures server synchronization

ABAP Enqueue
Service

Central Services
Instance ABAP

■ Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher

■ Keeps a list of application servers that can
be reached within the system.

ABAP Message
Service

■ Manages logical locks.

■ Ensures server synchronization.

JavaEnqueueServiceCentral Services
Instance Java
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Table 2-1 SAP architecture (continued)

FunctionsServiceComponentArchitecture

■ Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.

■ Provides cluster state information to SAP
Web Dispatcher

■ Keeps a list of application servers that can
be reached within the system.

JavaMessage Service

Enables the lock table to be replicated on a
second server, the replication server.

ABAP Enqueue
Replication Service

Enqueue Replication
Instance ABAP

Enables the lock table to be replicated on a
second server, the replication server.

Java Enqueue
Replication Service

Enqueue Replication
Instance Java

Manages the master data in multiple MDM
repositories along with catering to various
clients across the network.

Master Data ServiceMaster Data ServerSAP NetWeaver MDM

Interacts with the MDM Data Server to
perform automated data imports into an
MDM repository. It is an automated version
of the MDM Import Manager.

Master Data ServiceMaster Data Import
Server

SAP NetWeaver MDM

Interacts with the MDM Data Server to
performautomated syndication of data from
an MDM repository. It is an automated
version of the MDM Syndicator.

Master Data ServiceMaster Data
Syndication Server

SAP NetWeaver MDM

Workswith theMDMDataServer andenables
the publication ofmaster data from anMDM
repository.

Master Data ServiceMaster Data Layout
Server

SAP NetWeaver MDM

Single Point of Failures (SPOF)
In a distributed SAP environment, the following components are critical for
application availability. Hence, these components need to be protected.

■ Database Instance

■ Central Instance

■ Dialog Instance

■ Central Services Instance

Installing and configuring the SAP NetWeaver for high availability
About SAP NetWeaver
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■ SAP Central File System

■ SAP Master Data Management

Table 2-2 lists the possibilities to eliminate the single point of failures.

Table 2-2 Possibilities to secure the single point of failures

Technical Possibilities to eliminate the SPOFSingle Point of Failure

Switch-over solutionsCentral Database

Set up an Enqueue Replication Server controlled by
a switch-over solution

Central Services

Switch-over solutionsCentral Instance/Dialog Instance

Switch-over solutionsSAP Central File System

Switch-over solutionsSAP MDM

About SAPCPE
SAPCPE is a generic tool developed by SAP. The SAP startup framework launches
this tool before starting the actual instance.

SAPCPE is used in every high availability setup to automate the synchronization
of binaries and executables from a central location
(\\SAPGLOBALHOST\sapmnt\SYS\exe\run) to the instance specific local disks
(drive:\usr\sap\SID\InstName\exe). The SAPCPE tool requires the list of target
files to enable this synchronization.

Uniquely identifying SAP server instances
You can virtualize an SAP instance using a cluster. Using shared disk and virtual
IP addresses, you can manage a large set of SAP instances in a single cluster. For
example, Dialog and Central instances can run on separate cluster nodes or can
run concurrently on a single node.

In cases such as multiple instances running concurrently on a single node, the
agent for SAP NetWeaver must be able to uniquely identify each SAP instance on
a single host system.

To uniquely identify each SAP instance, set the SAPSID and InstName attributes
such that the combined values of SAPSID and the last two characters of InstName
are unique for each SAP instance.
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Differentiating SAP instances is important when the Agent for SAP NetWeaver
must kill the processes of a non-responsive or failed instance. In absence of unique
names for each server, the agentmaykill processes formore thanoneSAP instance
during a clean operation.

Monitoring an SAP instance
The monitor function performs process level check to ensure the proper
functioning of an SAP instance.

The ProcMon attribute specifies the processes that must be running successfully
for a particular SAP instance type. Themonitor function uses this list of processes
to scan the process table, and verify that the processes are running successfully.

Table 2-3 contains valid values for the ProcMon attribute.

Table 2-3 Valid values for the ProcMon attribute

Value for ProcMon attributeSAP instance typeSAP usage type

For CENTRAL:

■ Mandatory: disp+work.exe,
msg_server.exe

■ Optional: igswd.exe, icman.exe,
and gwrd.exe

Note: msg_server.exe is not
applicable for a Central instance,
if a Standalone Enqueue server
instance is configured.

For DIALOG:

■ Mandatory: disp+work.exe

■ Optional: igswd.exe, icman.exe
and gwrd.exe

For ENQUEUE:

■ msg_server.exe

■ enserver.exe

For ENQREP

■ enrepserver.exe

■ CENTRAL

■ DIALOG

■ ENQUEUE

■ ENQREP

ABAP

Installing and configuring the SAP NetWeaver for high availability
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Table 2-3 Valid values for the ProcMon attribute (continued)

Value for ProcMon attributeSAP instance typeSAP usage type

For CENTRAL:

■ Mandatory: jcontrol.exe

■ Optional: icman.exe

For DIALOG:

■ Mandatory: jcontrol.exe

■ Optional: icman.exe

For ENQUEUE:

■ Mandatory: disp+work.exe,
jcontrol.exe

■ Optional: igswd.exe, icman.exe
and gwrd.exe

For ENQREP

■ enrepserver.exe

■ CENTRAL

■ DIALOG

■ ENQUEUE

■ ENQREP

Java

For CENTRAL

■ Mandatory: disp+work.exe,
msg_server.exe, jcontrol.exe

■ Optional: igswd.exe, icman.exe
and gwrd.exe

DIALOG

■ Mandatory: disp+work.exe,
jcontrol.exe

■ Optional: igswd.exe, icman.exe
and gwrd.exe

For AENQUEUE (ABAP)

■ msg_server.exe

■ enserver.exe

For JENQUEUE (Java)

■ enrepserver.exe

For AENQREP (ABAP)

■ msg_server.exe

■ enserver.exe

For JENQREP (Java)

■ enrepserver.exe

■ CENTRAL

■ DIALOG

■ AENQUEUE (ABAP)

■ JENQUEUE (Java)

■ AENQREP (REP)

■ JENQREP

Add-In (ABAP + Java)
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Table 2-3 Valid values for the ProcMon attribute (continued)

Value for ProcMon attributeSAP instance typeSAP usage type

■ MDS.exe for Master Server

■ MDIS.exe for Import Server

■ MDSS.exe for Syndication
Server

■ MDLS.exe for Layout server

MDMSAP MDM

Themonitor function takes a snapshot of the running process table. The function
compares the processes that the ProcMon attribute specifies, to the set of running
SAP processes. If any process is missing, the function declares the SAP instance
as offline, and bypasses further monitor operations.

About installing SAP NetWeaver for high availability
You can install SAP NetWeaver in the following ways, in a VCS environment:

SAP instance binaries are installed on shared disks.SAP instance on shared disk

SAP instance binaries are installed locally on each node.SAP instance on local disk

When installing SAP NetWeaver, ensure that the login_name, group_name for
the sidadm and SAPServiceSID is the same on all the nodes.

About configuringSAPNetWeaver for high availability
The guidelines for configuring SAPNetWeaver for high availability are as follows:

■ In a service group, keep the single point of failure as minimal as possible and
watch the application startup time.

■ Assignavirtual hostname to the componentwithin the switchover envionment.
Since the physical hostname changes with the switchover, this is a must have
requirement.

■ Based on the expected failover time configure the reconnection parameters
for all software components and enable its automatic reconnection.

■ Configure sapcpe tool to load the executables fromcentral file share to instance
specific directory.

Installing and configuring the SAP NetWeaver for high availability
About installing SAP NetWeaver for high availability
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Setting up SAP systems for clustering
This topic describes the procedure to install and configure SAP on a Windows
system, so that you can cluster the system in a Veritas Cluster Server (VCS)
environment.

Symantec recommends installing and clustering a database server for SAP to
minimize SAP system downtime. An SAP system downtime may happen due to
database unavailability.

In this installation, it is assumed that you are setting up the system on two or
more nodes, and clustering these nodes in a VCS environment.

Note: Symantec strongly recommends that a trained SAP consultant be involved
in performing the installation procedure.

Setting up a pre-installed SAP R/3 system
If you have a previously installed SAP stem, the system can be of the following
types:

■ A domain administrator installed the system with a virtual hostname.

■ A domain administrator installed the system with a local hostname.

■ A local administrator installed the system with a virtual hostname.

■ A local administrator installed the system with a local hostname.

For a domain administrator that has installed the SAP system using a virtual
hostname.

See “Clustering an SAP instance” on page 62.

For all other types, perform the following procedures as applicable:

■ Converting a local installation into a domain installation

■ Converting the local environment into a virtual environment

Converting a local installation into a domain installation
If a local administrator has installed the SAP system, convert the installation into
a domain installation.
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To convert a local installation into a domain installation

1 Ensure that the necessary user accounts and user groups such as sapsidadm,
SAPserviceSAPSID, and so on, exist in the domain controller.

For details about creating user accounts and user groups in the domain
controller:

See “Creating and adding domain groups and users” on page 69.

2 Add these domainuser accounts to the SAP server, and assign these accounts
to the group of local administrators for the SAP server.

For details about adding local groups and users:

See “Creating and adding local groups and users” on page 72.

3 The SAP services, such as SAP<SAPSID>_<xx> and SAPOSCol, use a user to
begin execution.

Change the user of these services as follows:

■ Stop the SAP system and its services.

■ For each service, right-click the service, and select Properties.

■ In the Service Properties dialog box, click the Logon tab.

■ Change the user of the service to the domain user that you created in step
1.

4 Ensure that the sapmnt and saploc directories are shared, and are accessible
by the domain user.

Perform the following steps in the order presented:

■ Right-click the <drive>:\usr\sap directory, and select Properties.

■ In the Properties dialog box, click the Sharing tab.

■ Click Share this folder.

■ Enter sapmnt in the Share name field.

■ Click Permissions.

■ In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt
directory.

■ Click OK in the Permissions for sapmnt dialog box.

■ In the Properties dialog box, click New Share.

■ In the New Share dialog box, enter saploc in the Share name field.

■ Click OK in the New Share dialog box.

Installing and configuring the SAP NetWeaver for high availability
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■ Click Permissions.

■ In the Permissions for saploc dialog box, ensure that the Administrators
andSAP_LocalAdminuser groupshave full control for the saplocdirectory.

■ Click OK in the Permissions for saploc dialog box.

■ Click OK in the Properties dialog box.

5 Restart the SAP system and its services.

Converting the local environment into a virtual environment
If the SAP system uses a local hostname, youmust convert the local environment
of the system into a virtual environment.

Note: Ensure that a domain administrator has installed the SAP installation. If
the installation is local, convert the installation into a domain installation.

See “Converting a local installation into a domain installation” on page 29.

To convert the local environment into a virtual environment

1 Onall the nodes in the cluster, set the sapsidadmuser environment variables.

Do the following tasks, in the order presented:

■ Open a command prompt window.

■ At the command prompt, type runas /profile

/user:<domain>\<sapsid>adm regedit.

■ In the Registry Editor dialog box, click HKEY_CURRENT_USER >
Environment.

■ Set the environment variables.
See “Setting the environment variables” on page 34.

2 On the drive where SAP is installed, access the DEFAULT.PFL file in the
<drive>:\usr\sap\SAPSID\SYS\profile directory.

Do the following tasks, in the order presented:

■ Set the SAPDBHOST parameter as equal to the virtual hostname of the
database server.

■ Set any references of the database server as equal to the virtual hostname
of the database server.

■ Set all other references of the local hostname as equal to the virtual
hostname of the SAP instance.
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3 On the drive where SAP is installed, access the START profile in the
<drive>:\usr\sap\SAPSID\SYS\profile directory.

Do the following tasks, in the order presented:

■ Rename the START_InstName_RealHostname file to reflect the virtual
hostname of the SAP instance.
The filename becomes START_InstName_VirtualHostname.

■ Set the SAPGLOBALHOST parameter as equal to the virtual hostname of
the Central instance.

■ Set the SAPLOCALHOST and SAPLOCALHOSTFULL parameters as equal
to the virtual hostname of the instance.

■ Comment out the SAP commands that initiate the database. The
appropriate database agent must initiate the database.

■ Change all other references of the local hostname as equal to the virtual
hostname of the instance.

4 On the drive where SAP is installed, access the instance profile in the
<drive>:\usr\sap\SAPSID\SYS\profile directory.

Do the following tasks, in the order presented:

■ Rename the SAPSID_InstName_RealHostname file to reflect the virtual
hostname of the SAP instance.
The filename becomes SAPSID_InstName_VirtualHostname.

■ Set the SAPGLOBALHOST parameter as equal to the virtual hostname of
the Central instance.

■ Set the SAPLOCALHOST and SAPLOCALHOSTFULL parameters as equal
to the virtual hostname of the instance.

■ Change all other references of the local hostname as equal to the virtual
hostname of the instance.

5 On the drive where SAP is installed, access the igs.xml file in the
<drive>:\usr\sap\SAPSID\InstName\igs\conf directory.

Do the following tasks, in the order presented:

■ Set the ip parameter in MUX as equal to the virtual hostname of the
instance.

■ Set the gwhost parameter as equal to the virtual hostnameof the instance.

■ Change all other references to the local hostname as equal to the virtual
hostname of the instance.
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6 On the drive in which SAP is installed, access the
<drive>:\usr\sap\SAPSID\SYS\exe\run directory or
<drive>:\usr\sap\SAPSID\InstName\exe directory.

7 Use the sapstartsrv.exe command to recreate the Windows service entry.

8 Perform either of these steps to recreate the service entry as follows:

■ At the command prompt run the sapstartsrv.exe command.

■ In the SAPService Install/Uninstall dialog box, enter the following values:

SAPSIDSID

InstIDNR

■ For a global host:

<drive>:\usr\sap\SAPSID\SYS\profile\START_
InstName_Virtual_HostName

■ For other hosts:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\
SYS\profile\START_<InstName>_<Virtual_
HostName>

Startprofile

<SAPAdminDomain>\SAPService<SAPSID>User

<SAPService<SAPSID> password>Password

ManualStartup Type

<SAPAdminDomain>\<sapsid>admUse Environment of user

■ Click OK.

■ Create the Windows service entry using the following command:

sapstartsrv.exe -r -q -s <SAPSID> -n <InstID> -U\

<SAPAdminDomain>\SAPService<SAPSID> -P\ <SAPService<SAPSID>

password> -p

■ For a global host, add the following lines:

<drive>:\usr\sap\<SAPSID>\SYS\profile\START_<InstName>_<V.Ho

stName> -e <SAPAdminDomain>\<sapsid>adm

■ For other hosts, add the following lines:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile\START_<InstNam

e>_<Virtual_HostName> -e <SAPAdminDomain>\<sapsid>adm
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9 As and where applicable, backup the following directories by renaming the
directories:

<drive>:\usr\sap\<SAPSID>\SYS

<drive>:\usr\sap\<SAPSID>\SYS\profile

<drive>:\usr\sap\<SAPSID>\SYS\global

<drive>:\usr\sap\<SAPSID>\<InstName>

10 As and where applicable, create and mount a new shared volume for the
following mount points:

<drive>:\usr\sap\<SAPSID>\SYS

<drive>:\usr\sap\<SAPSID>\SYS\profile

<drive>:\usr\sap\<SAPSID>\SYS\global

<drive>:\usr\sap\<SAPSID>\<InstName>

11 Copy the file referenced in step 9 into the new volumes, as and where
applicable.

12 On the nodes in the cluster where the files referenced in step 9, were not
modified, recreate these directories:

<drive>:\usr\sap\<SAPSID>\SYS

<drive>:\usr\sap\<SAPSID>\SYS\profile

<drive>:\usr\sap\<SAPSID>\SYS\global

<drive>:\usr\sap\<SAPSID>\<InstName>

The SAP system is now ready for clustering. For details about clustering:

See “Clustering an SAP instance” on page 62.

Setting the environment variables
Table 2-4 lists the environment variables that you need to convert the local
environment into a virtual environment.

The database server is a Microsoft SQL database server.

Table 2-4 Environment variables

DataParameter typeParameter name

MSSREG_SZDBMS_TYPE

<SAPSID>REG_SZMSSQL_DBNAME

<sapsid>REG_SZMSSQL_SCHEMA
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Table 2-4 Environment variables (continued)

DataParameter typeParameter name

<DBHost>\<DBInstance>REG_SZMSSQL_SERVER

<Path to all SAP instances’
binaries in the SAP system>

Separate each instance path
with ;.

REG_EXPAND_SZPATH

<SAPGLOBALHOST>REG_SZSAPGLOBALHOST

<SAPLOCALHOST>REG_SZSAPLOCALHOST

C:\WINDOWS\TEMPREG_EXPAND_SZTEMP

C:\WINDOWS\TEMPREG_EXPAND_SZTMP

Note: For Oracle database, configure the the environment variables accordingly.

FreshSAP installation: Installing anSAPABAP system
This section describes the procedure to install an SAP system with ABAP
architecture in a highly available environment. The procedure assumes that VCS
is installed on the system.

Installing an SAP ABAP ASCS instance
This section is applicable for SAPNetWeaver 04s only. Follow these steps to install
an SAP ABAP ASCS instance.

To install an SAP ABAP ASCS instance

1 Log in as a user that has domain administrator rights.

2 Create a VCS Service Group with IP and Lanman resources.

For details about creating VCS Service Groups, refer to the VCS user
documentation.

3 Before beginning to install the SAP ABAP ASCS instance, bring the Service
Group online.
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4 On the node that has the Service Group online, start the SAP installation.

Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use theSAPINST_USE_HOSTNAMEparameter to launch theSAP installation
GUI in a virtual environment. At the command prompt, run this command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:

<Virtual Host Name> is the virtual lanman name that you created in step 2.

5 From the installation GUI, select High-Availability System > Based on AS
ABAP > Central Services Instance for ABAP (ASCS) and follow the
instructions to complete the installation.

Installing an SAP ABAP Central instance
Follow these steps to install an SAP ABAP Central instance.

To install an SAP ABAP Central instance

1 Log in as a user that has domain administrator rights.

2 Create a VCS Service Group with IP and Lanman resources.

For details about creating VCS Service Groups, refer to the VCS user
documentation.

3 Before beginning to install the Central instance, bring the Service Group
online.

4 On the node that has the Service Group online, start the SAP installation.

Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use theSAPINST_USE_HOSTNAMEparameter to launch theSAP installation
GUI in a virtual environment. At the command prompt, run this command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:

<Virtual Host Name> is the virtual lanman name that you created in step 2.

Follow the instructions in the SAP installation GUI, and complete the SAP
Central instance installation.

Installing the SAP Central instance populates the SAPGLOBALHOST
parameter. This step is not applicable for SAP NetWeaver 04s.
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To install an SAP ABAP Central instance for SAP NetWeaver 04s

1 Select High-Availability System > Based on AS ABAP > Central Instance
from the SAP installation GUI and follow the instructions to complete the
installation.

2 Under SAP System Parameters, specify the virtual SCS host name in the
Profile Directory field. For example:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing an SAP ABAP Database instance
On thenodewhere thedatabase is upand running, begin theSAPdatabase instance
installation.

Do not double-click the sapinst.exe file to launch the SAP installation GUI. Use
the SAPINST_USE_HOSTNAME parameter to launch the SAP installation GUI in
a virtual environment. At the command prompt, run the following command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:

<VirtualHostName> is the virtual hostname of the systemonwhich the database
is running.

Follow the instructions in theSAP installationGUI, and complete theSAPDatabase
instance installation.

Installing an SAP ABAP Dialog instance
Follow these steps to install an SAP ABAP Dialog instance.

To install SAP ABAP Dialog instance

1 Log in as a user that has domain administrator rights.

2 Create a VCS Service Group with IP and Lanman resources.

For details about creating VCS Service Groups, refer to the VCS user
documentation.
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3 Before beginning to install theDialog instance, bring theServiceGrouponline.

4 On the node that has the Service Group online, start the SAP installation.

Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use theSAPINST_USE_HOSTNAMEparameter to launch theSAP installation
GUI in a virtual environment. At the command prompt, run this command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:

<Virtual Host Name> is the virtual lanman name that you created in step 2.

Follow the instructions in the SAP installation GUI, and complete the SAP
Dialog instance installation.

To install an SAP ABAP Dialog instance for SAP NetWeaver 04s

1 Select High-Availability System > Based on AS ABAP > Dialog Instance
from the SAP installation GUI and follow the instructions to complete the
installation.

2 Under SAP System Parameters, specify the virtual SCS host name in the
Profile Directory field. For example:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

For details about clustering:

See “Clustering an SAP instance” on page 62.

Installing an SAP ABAP Standalone Enqueue server
The Standalone Enqueue server is shipped along with the standard SAP
installation, but the sapinst.exe file does not install and configure the Enqueue
server. Youmust configure the server separately, after installing the SAP Central
instance.

This section is applicable for the versions lesser than SAP NetWeaver 04s.

Assume the following:

■ Central instance is DVEBMGS<xx>.

■ SAP system name is EC4.

■ Virtual hostnames of the Standalone Enqueue server and application server
instances are SAPEC4ASCS and SAPEC4CI respectively.

■ Instance numbers for the Standalone Enqueue server and application server
instances are 10 and 12 respectively.
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You must first split the Central instance into two instances. For example, split
DVEBMGS<xx> into two instances, ASCS<xx> and DVBGS<yy>. The ASCS<xx> instance
includes all the centralized components.

The ASCS<xx> instance is anEnqueue server instance, and the DVBGS<yy> instance
is an application server instance.

To install and configure a SAP ABAP Standalone Enqueue server

1 Make two copies of the start and instance profiles of the Central instance.

2 Name the start profiles as follows:

■ START_DVBGS12_SAPEC4CI

start profile for an application server instance

■ START_ASCS10_SAPEC4ASCS

start profile for a Standalone Enqueue server instance

3 In the START_DVBGS12_SAPEC4CI profile, do the following:

■ Change the values of the following parameters:

DVBGS12INSTANCE_NAME

SAPEC4ASCSSAPGLOBALHOST

SAPEC4CISAPLOCALHOST

12SAPSYSTEM

c:\usr\sap\EC4\DVBGS12DIR_INSTANCE

$(DIR_INSTANCE)\exeDIR_EXECUTABLE

$(DIR_INSTANCE)\exeDIR_LIBRARY

\\SAPEC4ASCS\sapmnt\EC4\SYS\profileDIR_PROFILE

\\SAPEC4ASCS\sapmnt\EC4\SYS\globalDIR_GLOBAL

\\SAPEC4ASCS\sapmnt\EC4\SYS\exe\runDIR_CT_RUN

■ Remove the following lines:

_DB=strdbs.cmd

Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) EC4

_MS=msg_server.exe

Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS) pf=$(DIR_PROFILE)\

EC4_DVEBMGS10_SAPEC4ASCS

_DW=disp+work.exe
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Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW) pf=$(DIR_PROFILE)\

EC4_DVEBMGS10_SAPEC4ASCS

_IGS=igswd.exe

Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)

-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=EC4 -sysno=10

■ Add the following lines:

_CP=sapcpe.exe

Start_Program_01=immediate $(DIR_EXECUTABLE)\$(_CP)

pf=$(DIR_PROFILE)\EC4_DVBGS12_SAPEC4CI

_DW=disp+work.exe

Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW)

pf=$(DIR_PROFILE)\EC4_DVBGS12_SAPEC4CI

_IGS=igswd.exe

Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)

-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=EC4 -sysno=12

4 In the START_ASCS10_SAPEC4ASCS profile, do the following:

■ Change the values of the following parameters:

SAPEC4ASCSSAPGLOBALHOST

SAPEC4ASCSSAPLOCALHOST

ASCS10INSTANCE_NAME

10SAPSYSTEM

c:\usr\sap\EC4\ASCS10\exeDIR_EXECUTABLE

c:\usr\sap\EC4\ASCS10\exeDIR_LIBRARY

c:\usr\sap\EC4\SYS\profileDIR_PROFILE

c:\usr\sap\EC4\SYS\globalDIR_GLOBAL

C:\usr\sap\EC4\SYS\exe\runDIR_CT_RUN

■ Remove the following lines:

_DB=strdbs.cmd

Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) EC4

_MS=msg_server.exe

Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS)

pf=$(DIR_PROFILE)\EC4_DVEBMGS10_SAPEC4ASCS
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_DW=disp+work.exe

Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW)

pf=$(DIR_PROFILE)\EC4_DVEBMGS10_SAPEC4ASCS

_IGS=igswd.exe

Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)

-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=EC4 -sysno=10

■ Add the following lines:

_CP = sapcpe.exe

Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)

pf=$(DIR_PROFILE)\EC4_ASCS10_SAPEC4ASCS

_MS=msg_server.exe

Start_Program_01=local $(DIR_EXECUTABLE)\$(_MS)

pf=$(DIR_PROFILE)\EC4_ASCS10_SAPEC4ASCS

_EN = enserver.exe

Start_Program_02 = local $(DIR_EXECUTABLE)\$(_EN)

pf=$(DIR_PROFILE)\EC4_ASCS10_SAPEC4ASCS

5 Name the instance profiles as follows:

■ EC4_DVBGS12_SAPEC4CI

instance profile of the application server instance

■ EC4_ASCS10_SAPEC4ASCS

instance profile of the Standalone Enqueue server instance

6 In the EC4_DVBGS12_SAPEC4CI profile, do the following:

■ Change the values of the following parameters:

DVBGS12INSTANCE_NAME

12SAPSYSTEM

SAPEC4ASCSSAPGLOBALHOST

SAPEC4CISAPLOCALHOST

\\SAPEC4ASCS\sapmnt\EC4\SYS\globalDIR_GLOBAL

\\SAPEC4ASCS\sapmnt\EC4\SYS\profileDIR_PROFILE

C:\usr\sap\EC4\DVBGS12DIR_INSTANCE

$(DIR_INSTANCE)\exeDIR_EXECUTABLE

\\SAPEC4ASCS\sapmnt\EC4\SYS\exe\runDIR_CT_RUN
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\\SAPEC4ASCS\sapmnt\transDIR_TRANS

■ Remove the following line.

rdisp/wp_no_enq=1

■ Change the value of PORT in the following line.

icm/server_port_0=PROT=HTTP,PORT=8012

7 In the EC4_ASCS10_SAPEC4ASCS profile, do the following:

■ Change the values of the following parameters:

ASCS10INSTANCE_NAME

SAPEC4ASCSSAPGLOBALHOST

SAPEC4ASCSSAPLOCALHOST

10SAPSYSTEM

■ Remove the following lines:

rdisp/wp_no_dia=2

rdisp/wp_no_btc=2

rdisp/wp_no_vb=1

rdisp/wp_no_vb2=1

rdisp/wp_no_enq=1

rdisp/wp_no_spo=1

PHYS_MEMSIZE=512

DIR_TRANS=C:\usr\sap\trans

icm/server_port_0=PROT=HTTP,PORT=8010

■ Add the following lines:

rdisp/myname = SAPEC4ASCS_EC4_10

enque/server/threadcount = 1

ipc/shm_psize_34 = 0

enque/table_size = 4096

enque/deque_wait_answer = FALSE

enque/process_location = LOCAL

enque/encni/port = 3210

rdisp/enqname = $(rdisp/myname)

enque/snapshot_pck_ids = 100
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rdisp/mshost=SAPEC4ASCS

rdisp/msserv = 3610

ms/server_port_0=PROT=HTTP, PORT=8110

8 In the DEFAULT.PFL file, do the following:

■ Remove the following lines:

SAPDBHOST=SAPEC4ASCS

rdisp/accept_remote_trace_level=0

rdisp/sna_gateway=SAPEC4ASCS

rdisp/sna_gw_service=sapgw10

rslg/collect_daemon/listen_port=37

rslg/collect_daemon/talk_port=13

rdisp/bufrefmode=sendoff,exeauto

dbms/type=mss

dbs/mss/server=SAPNWDB\SQLINST01

dbs/mss/schema=ec4

dbs/mss/dbname=EC4

■ Add these lines:

SAPDBHOST=SAPNWDB #virtual hostname of the database server

rdisp/accept_remote_trace_level=0

rdisp/sna_gateway=SAPEC4CI

rdisp/sna_gw_service=sapgw12

rslg/collect_daemon/listen_port=37

rslg/collect_daemon/talk_port=13

rdisp/bufrefmode=sendon,exeauto

dbms/type=mss

dbs/mss/server=SAPNWDB\SQLINST01

dbs/mss/schema=ec4

dbs/mss/dbname=EC4

enque/process_location = REMOTESA

enque/serverhost = SAPEC4ASCS

enque/serverinst = 10

enque/encni/port = 3210

The Standalone Enqueue server is now configured and is ready for clustering.
For details about clustering:

See “Clustering an SAP instance” on page 62.
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Installing an SAP ABAP Enqueue Replication server
Follow the instructions here to install and configure an SAP ABAP Enqueue
Replication server.

See “Installing an SAP Enqueue Replication server” on page 58.

Fresh SAP installation: Installing an SAP Java system
This section describes the procedure to install an SAP system with Java
architecture in a highly available environment. The procedure assumes that VCS
is installed on the system.

Perform the instance installation in the order presented as follows.

Installing an SAP Java Central Services instance
This section explains the steps to install an SAP Java Central Services instance.

To install an SAP Java Central Services instance

1 Log in as a user that has domain administrator rights.

2 Create a VCS Service Group with IP and Lanman resources.

For details about creating VCS Service Groups, refer to the VCS user
documentation.

3 Before beginning to install the SAP Java Central Services instance, bring the
Service Group online.
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4 On the node that has the Service Group online, start the SAP installation.

Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use theSAPINST_USE_HOSTNAMEparameter to launch theSAP installation
GUI in a virtual environment. At the command prompt, run the following
command:

<path>\sapinst.exe

SAPINST_USE_HOSTNAME=<Virtual Host Name>

SAP NetWeaver 04s

<path>\sapinst.exe

SAPINST_USE_HOSTNAME=<Virtual Host Name>

product_ha.catalog

Other SAP versions

where:

<Virtual Host Name> is the virtual lanman name that you created in step 2.

5 From the installation GUI, select one of the following options and follow the
instructions to complete the installation.

High-Availability System > Based on AS Java > Central
Services Instance (SCS)

SAP NetWeaver 04s

SAP Java Central Services InstanceOther SAP versions

Installing an SAP Java Database instance
This section is applicable for SAPNetWeaver 04s only. Follow these steps to install
an SAP Java Database instance.
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To install an SAP Java Database instance

1 On the node where the database is up and running, begin the SAP database
instance installation.

Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use theSAPINST_USE_HOSTNAMEparameter to launch theSAP installation
GUI in a virtual environment. At the command prompt, run the following
command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:

<Virtual Host Name> is the virtual hostname of the system on which the
database is running.

2 From the installation GUI, select High-Availability System > Based on AS
Java > Database Instance and follow the instructions to complete the
installation.

Installing an SAP Java Central instance
Ensure that you install an SAP Java Central Services instance before installing a
Central instance.

See “Installing an SAP Java Central Services instance” on page 44.

For SAP NetWeaver 04s, use the following command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

For other versions, use the following command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

product_ha.catalog

Select the option for SAP Java Central instance from the installation GUI, and
follow the instructions to complete the installation.

When prompted for the SCS instance host name, enter the virtual host name of
the SAP Java Central Services instance.

For SAP NetWeaver 04s, do the following:

■ Select High-AvailabilitySystem>BasedonASJava>Central Instance from
the SAP installation GUI and follow the instructions to complete the
installation.

■ Under SAPSystemParameters, specify the virtual SCShost name in theProfile
Directory field. For example:
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\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing an SAP Java Dialog instance
This section explains the steps to install an SAP Java Dialog instance.

To install an SAP Java Dialog instance

Install the Java Dialog instance.

See “Installing an SAP ABAP Dialog instance” on page 37.

For SAP NetWeaver 04s, use the following command:

<Path_to_SAPInst>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

For other SAP versions, use the following command:

<Path_to_SAPInst>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

product_ha.catalog

Select the option for SAP Java Dialog instance from the installation GUI, and
follow the instructions to complete the installation.

When prompted for the Central instance host name, enter the virtual host name
of the SAP Java Central Services instance.

For SAP NetWeaver 04s, do the following:

■ Select High-Availability System > Based on AS Java > Dialog Instance from
the SAP installation GUI and follow the instructions to complete the
installation.

■ Under SAPSystemParameters, specify the virtual SCShost name in theProfile
Directory field. For example:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

For details about clustering:

See “Clustering an SAP instance” on page 62.

Installing an SAP Java Enqueue Replication server
Follow the instructions to install and configure an SAP Java Enqueue Replication
server.

See “Installing an SAP Enqueue Replication server” on page 58.
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FreshSAP installation: Installing a JavaAdd-In system
(ABAP + Java)

This section describes the procedure to install an SAP system in which a Java
Add-In is added to the ABAP architecture in a highly available environment. The
procedure assumes that VCS is installed on the system.

Perform the instance installation in the order presented as follows.

Installing an SAP Add-In ASCS instance
This section is applicable for SAP NetWeaver 04s only. Follow the instructions to
install an SAP Add-In ASCS instance.

See “Installing an SAP ABAP ASCS instance” on page 35.

From the installation GUI, select High-AvailabilitySystem>BasedonASABAP
and AS Java > Central Services Instance for ABAP (ASCS) and follow the
instructions to complete the installation.

Installing an SAP Add-In SCS instance
This section is applicable for SAP NetWeaver 04s only. Follow the instructions to
install an SAP Add-In SCS instance. Use the IP and Lanman resources that you
created for the SAP Add-In ASCS instance.

See “Installing an SAP Add-In ASCS instance” on page 48.

To install an SAP Add-In SCS instance

1 Log in as a user that has domain administrator rights.

2 Before beginning to install the SAP Add-In SCS instance, bring the Service
Group in which the SAP Add-In ABAP instance is installed, online.

3 On the node that has the Service Group online, start the SAP installation. Do
not double-click the sapinst.exe file to launch the SAP installationGUI.Use
the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run this command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:<Virtual Host Name> is the virtual lanman name.

4 From the installation GUI, select High-Availability System > Based on AS
ABAP > Central Services Instance (SCS) and follow the instructions to
complete the installation.
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Installing an SAP ABAP Central instance for an Add-In system
Follow the instructions to install an SAP ABAP Central instance.

See “Installing an SAP ABAP Central instance” on page 36.

For SAP NetWeaver 04s, do the following:

■ Select High-Availability System > Based on AS ABAP and AS Java > Central
Instance from the installation GUI, to install an SAPAdd-In Central instance.

■ Under SAPSystemParameters, specify the virtual SCShost name in theProfile
Directory field. For example:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing an SAP ABAP Database instance for an Add-In system
Install an SAP ABAP Database instance.

See “Installing an SAP ABAP Database instance” on page 37.

For SAP NetWeaver 04s, do the following:

■ SelectHigh-AvailabilitySystem>BasedonASABAPandASJava>Database
Instance from the installationGUI, to install anSAPAdd-InDatabase instance.

■ Under SAPSystemParameters, specify the virtual SCShost name in theProfile
Directory field. For example:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing a Java Add-In for a Central instance
For SAP NetWeaver 04s, this section is not applicable if you select the
High-Availability option while installing the SAP ABAP Central instance for an
Add-In system.

After installing the SAP ABAP Central and Database instance, follow these steps
to install a Java Add-In for the Central instance.
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To install a Java Add-In for a Central instance

1 Log in as a user that has domain administrator rights.

2 Bring the service group, which you created in the SAPABAPCentral instance
for an Add-In system, online.

See “Installing an SAP ABAP Central instance for an Add-In system”
on page 49.

3 On the node that has the Service Group online, start the Java Add-In system
installation.

Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use theSAPINST_USE_HOSTNAMEparameter to launch theSAP installation
GUI in a virtual environment. At the command prompt, run this command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:

<Virtual Host Name> is the virtual lanman name of the SAP Add-In Central
instance.

Select JavaAdd-InforABAP>JavaSystemFinalization from the installation
GUI, and follow the instructions to complete the installation.

Installing an SAP ABAP Dialog instance for an Add-In system
Install an SAP ABAP dialog instance.

See “Installing an SAP ABAP Dialog instance” on page 37.

For SAP NetWeaver 04s, do the following:

■ Select High-Availability System > Based on AS ABAP and AS Java > Dialog
Instance from the installation GUI, to install an SAP Add-In Dialog instance.

■ Under SAPSystemParameters, specify the virtual SCShost name in theProfile
Directory field. For example:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing a Java Add-In for a Dialog instance
For SAP NetWeaver 04s, this section is not applicable if you select the
High-Availability option while installing the SAP ABAP Dialog instance for an
Add-In system.
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After installing an SAP ABAP Dialog instance, follow these steps to install a Java
Add-In for the Dialog instance.

To install a Java Add-In for a Dialog instance

1 Bring the dialog instance that you installed in the Java Add-In for a Dialog
instance, online.

See “Installing a Java Add-In for a Dialog instance” on page 50.

2 Begin the installation. Do not double-click the sapinst.exe file to launch the
SAP installation GUI. Use the SAPINST_USE_HOSTNAME parameter to
launch the SAP installation GUI in a virtual environment. At the command
prompt, run this command:

<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:

<Virtual Host Name> is the virtual lanman name of the SAP Add-In Central
instance.

Select Java Add-In for ABAP > Dialog Instance Finalization from the
installation GUI, and follow the instructions to complete the installation.

For details about clustering:

See “Clustering an SAP instance” on page 62.

Installing an SAP Add-In Standalone Enqueue server
For SAP NetWeaver 04s, this section is not applicable if you select the
High-Availability option in the SAP installationGUI. For SAPNetWeaver 04s, the
procedure to install an SAPAdd-In Standalone Enqueue server is integrated with
the SAPInst tool.

For other SAP versions, in an SAP Add-In system, you require the following:

■ A Standalone Enqueue server and a message server with ABAP architecture.

■ A Standalone Enqueue server and a message server with Java architecture.
This Enqueue server is shipped as part of the SAP installation.

For high availability, you must isolate the ASCS instance. To isolate the ASCS
instance, you must split the Central instance into two instances. One instance
includes the dialog, update, background, and spoolwork processes,while the other
instance becomes a disconnected ASCS instance, containing themessage and the
Enqueue servers.

If you restart this disconnected ASCS instance on the Central Services instance
host, the instance is relocated on the Central Services instance host.
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The remaining instance on the Central instance host must not be renamed as
DVBGS<xx>. Renaming this instancemay lead to problems with an existing J2EE
Add-In system, or with an awaiting J2EE installation. In addition, the path names
are firmly connected to various points in the J2EE engine. Therefore, this instance
name must not be changed. For more information, refer to SAP note 821904.

Before you install anSAPAdd-InStandaloneEnqueue server, assume the following:

■ The original Central instance is DVEBMGS<xx>, and the instance is split into
the following instances:

SAP Add-In Standalone Enqueue server instanceASCS<yy>

Application server instanceDVEBMGS<xx>

■ The value of SAPSID is XI1.

■ The virtual host name of the Central and Standalone Enqueue server is
SAPXI1ASCS.

■ The instance numbers of theCentral andStandaloneEnqueue server instances
are 41 and 42 respectively.

To install and configure an SAP Add-In Standalone Enqueue server

1 Make a copy of the start profile of the Central instance.

Name the start profiles as follows:

■ START_DVEBMGS41_SAPXI1ASCS
The start profile for the application server instance

■ START_ASCS42_SAPXI1ASCS
The start profile for the Standalone Enqueue server

2 In the START_DVEBMGS41_SAPXI1ASCS profile, do the following:

■ Change the values of the following parameters:

C:\usr\sap\XI1\SYS\exe\runDIR_EXECUTABLE

C:\usr\sap\XI1\SYS\exe\runDIR_LIBRARY

C:\usr\sap\XI1\DVEBMGS41DIR_INSTANCE

C:\usr\sap\XI1\SYS\globalDIR_GLOBAL

C:\usr\sap\XI1\SYS\profileDIR_PROFILE

C:\usr\sap\XI1\SYS\exe\runUDIR_CT_RUN
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■ Remove the following lines:

_DB=strdbs.cmd

Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) XI1

_MS=msg_server.exe

Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS)

pf=$(DIR_PROFILE)\XI1_DVEBMGS41_SAPXI1ASCS

3 In the START_ASCS42_SAPXI1ASCS profile, do the following:

■ Change the values of the following parameters:

SAPXI1ASCSSAPGLOBALHOST

SAPXI1ASCSSAPLOCALHOST

ASCS42INSTANCE_NAME

42SAPSYSTEM

C:\usr\sap\XI1\ASCS42\exeDIR_EXECUTABLE

C:\usr\sap\XI1\ASCS42\exeDIR_LIBRARY

C:\usr\sap\XI1\ASCS42DIR_INSTANCE

C:\usr\sap\XI1\SYS\globalDIR_GLOBAL

C:\usr\sap\XI1\SYS\profileDIR_PROFILE

C:\usr\sap\XI1\SYS\exe\runUDIR_CT_RUN

■ Remove the following lines:

_DB=strdbs.cmd

Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) XI1

_MS=msg_server.exe

Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS)

pf=$(DIR_PROFILE)\XI1_DVEBMGS41_SAPXI1ASCS

_DW=disp+work.exe

Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW)

pf=$(DIR_PROFILE)\XI1_DVEBMGS41_SAPXI1ASCS

_IGS=igswd.exe

Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)

-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=XI1 -sysno=41

■ Add the following lines:
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_CP = sapcpe.exe

Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)

list:$(DIR_CT_RUN)\instance.lst pf=$(DIR_PROFILE)\

XI1_ASCS42_SAPXI1ASCS

_MS=msg_server.exe

Start_Program_01=local $(DIR_EXECUTABLE)\$(_MS)

pf=$(DIR_PROFILE)\XI1_ASCS42_SAPXI1ASCS

_EN = enserver.exe

Start_Program_02 = local $(DIR_EXECUTABLE)\$(_EN)

pf=$(DIR_PROFILE)\XI1_ASCS42_SAPXI1ASCS

4 Make a copy of the instance profile of the Central instance.

Name the profiles as follows:

■ XI1_DVEBMGS41_SAPXI1ASCS

The instance profile for the Standalone Enqueue server instance

■ XI1_ASCS42_SAPXI1ASCS

The instance profile for the application server instance

5 In the XI1_DVEBMGS41_SAPXI1ASCS profile, do the following:

■ Change the values of the following parameters:

SAPXI1ASCSSAPGLOBALHOST

SAPXI1ASCSSAPLOCALHOST

DVEBMGS41INSTANCE_NAME

41SAPSYSTEM

C:\usr\sap\XI1\SYS\exe\runDIR_EXECUTABLE

C:\usr\sap\XI1\SYS\exe\runDIR_LIBRARY

C:\usr\sap\XI1\DVEBMGS41DIR_INSTANCE

C:\usr\sap\XI1\SYS\globalDIR_GLOBAL

C:\usr\sap\XI1\SYS\profileDIR_PROFILE

C:\usr\sap\XI1\SYS\exe\runUDIR_CT_RUN

■ Remove the following line:

rdisp/wp_no_enq = 1
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■ Add the following line:

enque/serverinst = 42

■ Change the value of PORT in the following line:

ms/server_port_0 = PROT=HTTP, PORT=8142

6 In the XI1_ASCS42_SAPXI1ASCS profile, do the following:

■ Change the values of the following parameters:

SAPXI1ASCSSAPGLOBALHOST

SAPXI1ASCSSAPLOCALHOST

ASCS42INSTANCE_NAME

42SAPSYSTEM

C:\usr\sap\XI1\ASCS42\exeDIR_EXECUTABLE

C:\usr\sap\XI1\SYS\globalDIR_GLOBAL

C:\usr\sap\XI1\SYS\profileDIR_PROFILE

C:\usr\sap\XI1\SYS\exe\runUDIR_CT_RUN

■ Remove the following lines:

rdisp/wp_no_dia = 2

rdisp/wp_no_btc = 2

rdisp/wp_no_vb = 1

rdisp/wp_no_vb2 = 1

rdisp/wp_no_enq = 1

rdisp/wp_no_spo = 1

PHYS_MEMSIZE = 512

DIR_TRANS = C:\usr\sap\trans

rdisp/start_icman = TRUE

icm/server_port_0 = PROT=HTTP,PORT=8041

exe/j2ee = $(DIR_INSTANCE)/j2ee/os_libs/jcontrol.exe

rdisp/j2ee_start_control = 1

rdisp/j2ee_start = 1

rdisp/j2ee_timeout = 600

rdisp/frfc_fallback = on

icm/HTTP/j2ee_0 = PREFIX=/,HOST=localhost,CONN=0-500,PORT=54100

jstartup/trimming_properties = off
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jstartup/protocol = on

exe/jlaunch = $(DIR_INSTANCE)/j2ee/os_libs/jlaunch.exe

jstartup/vm/home = C:\Program Files\j2sdk1.4.2_10

INSTANCE_PROPERTIES =

$(DIR_INSTANCE)/j2ee/cluster/instance.properties

SDM_PROPERTIES = $(DIR_INSTANCE)/SDM/program/config/

sdm_jstartup.properties

jstartup/instance_properties =

$(INSTANCE_PROPERTIES);$(SDM_PROPERTIES)

ms/server_port_0 = PROT=HTTP, PORT=8141

■ Add the following lines:

rdisp/msserv = 3642

enque/table_size = 4096

enque/deque_wait_answer = FALSE

enque/serverinst = 42

enque/process_location = LOCAL

enque/encni/port = 3242

rdisp/myname = SAPXI1ASCS_XI1_42

rdisp/enqname = $(rdisp/myname)

enque/snapshot_pck_ids = 100

ms/server_port_0 = PROT=HTTP, PORT=8142

enque/server/threadcount = 1

ipc/shm_psize_34 = 0

7 In the DEFAULT.PFL file, do the following:

■ Make SAPDBHOST equal to SAPNWDB, the virtual host name of the
database server.

■ Change the value of PORT in this line.

ms/server_port_0= PROT=HTTP, PORT=8142

■ Add the following lines:
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enque/process_location= REMOTESA

enque/serverhost= SAPXI1ASCS

enque/serverinst= 42

8 Go to the following services file, and change the value of the message server
port for the sapmsXI1 service to 3642/tcp:

c:\WINDOWS\system32\drivers\etc\servicesWindows 2003

C:\WINDOWS\system32\drivers\etc\servicesWindows 2008

The Java Add-In Enqueue server instance is configured and is ready for
clustering.

See “Clustering an SAP instance” on page 62.

Installing and configuring an SAP Add-In Enqueue Replication server
Perform the following instructions to install and configure anSAPAdd-InEnqueue
Replication server for an ABAP system.

See “Installing an SAP Enqueue Replication server” on page 58.

Perform the following instructions to install and configure anSAPAdd-InEnqueue
Replication server for a Java System.

See “Installing an SAP Enqueue Replication server” on page 58.

Fresh SAP installation: Installing SAP MDM Server
Components

This section describes the procedure to install an SAP system with MDM Server
components in a highly available environment. The procedure assumes that VCS
is installed on the system.

Install the following servers as SAP ABAP MDM Server instances:

1. SAP Master Data Server

2. SAP Master Data Import Server

3. SAP Master Data Syndication Server

4. SAP Master Data Layout Server

57Installing and configuring the SAP NetWeaver for high availability
Fresh SAP installation: Installing SAP MDM Server Components



To install SAP MDM instances

1 Log in as a user that has domain administrator rights.

2 Create a VCS service group with IP and Lanman resources.

For details about creating VCS service groups, refer to the Veritas Cluster
Server Administrator's Guide.

3 Bring the specific service group online.

4 Start the SAP installation on the node where the service group is online.

Note: Use the SAPINST_USE_HOSTNAME parameter to launch the SAP
installation. Do not double-click the sapinst.exe file to launch the SAP
installation GUI.

5 Change to the MDM media directory at the command prompt and run the
following command.

path\sapinst.exe SAPINST_USE_HOSTNAME=Virtual Host Name

where: Virtual Host Name is the virtual Lanman name that you created in
step 2.

6 Follow the instructions in the SAP installation GUI, and complete the
installation of SAP MDM instances.

To install an SAPMDM instance for SAPNetWeaverMDMServers other thanMaster
Data Server

1 Select Distributed System > Based on Server Type > Master Data

Server Instance from the SAP installation GUI and follow the instructions
to complete the installation.

2 For other MDM Server Instances under SAP System Parameters, specify the
virtual Master Data Server host name in the Profile Directory field.

For example: \\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.

Installing an SAP Enqueue Replication server
For a highly available clustering system, you must configure an Enqueue
Replication server along with a Standalone Enqueue server.

Note: Before configuring the Enqueue Replication server, refer to SAP Note
1018968.
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Before installing an Enqueue Replication server, install the Standalone Enqueue
server depending on the type of system as follows:

■ For an SAP ABAP system
See “Installing an SAP ABAP Standalone Enqueue server” on page 38.

■ For an SAP Add-In system
See “Installing an SAP Add-In Standalone Enqueue server” on page 51.

■ For anSAP Java system, youmust install an SAP JavaCentral Services instance
See “Installing an SAP Java Central Services instance” on page 44.

Before you install the SAP Enqueue Replication Server, assume the following:

■ The value of the SAPSID attribute is <sapsid>.

■ The virtual hostname of the Standalone Enqueue server is <enq_server>.
For anSAP Java system, consider<enq_server>as theSAP JavaCentral Services
instance.

■ The virtual hostname of the Enqueue Replication server is <rep_server>.

■ The instance number of the Standalone Enqueue server is <xx>.
For an SAP Java system, consider <xx> as the instance number of the SAP Java
Central Services instance.

■ The instance number of the Enqueue Replication server is <yy>.
Ensure that the instance numbers for the shared memory segments of the
Standalone Enqueue server and the Enqueue Replication server are the same.
Incase of a Standalone Enqueue server failure, this similarity facilitates the
Enqueue lock table takeover.

To install and configure an SAP Enqueue Replication Server

1 Add the following line in the <sapsid>_(A)SCS<xx>_<enq_server> profile:

enque/server/replication = true

Restart the (A)SCS<xx> instance for the changes to take effect.

2 Make a copy of the START_(A)SCS<xx>_<enq_server> start profile, and
rename the copy as START_REP<yy>_<rep_server>. This profile is the start
profile for the Enqueue Replication server instance.

3 In the START_REP<yy>_<rep_server> profile, do the following:

■ Change the values of the following parameters.

<yy>SAPSYSTEM

<xx>SCSID
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REP<yy>INSTANCE_NAME

<enq_server>SAPGLOBALHOST

<rep_server>SAPLOCALHOST

<drive>:\usr\sap\<sapsid>\INSTANCE_NAMEDIR_INSTANCE

<drive>:\usr\sap\<sapsid>\INSTANCE_NAME\exeDIR_EXECUTABLE

<drive>:\usr\sap\<sapsid>\INSTANCE_NAME\exeDIR_LIBRARY

\\<enq_server>\sapmnt\<sapsid>\SYS\profileDIR_PROFILE

\\<enq_server>\sapmnt\<sapsid>\SYS\globalDIR_GLOBAL

■ Remove the following lines:

_CP = sapcpe.exe

Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)

pf=$(DIR_PROFILE)\<sapsid>_(A)SCS<xx>_<enq_server>

_MS=msg_server.exe

Start_Program_01=local $(DIR_EXECUTABLE)\$(_MS)

pf=$(DIR_PROFILE)\<sapsid>_(A)SCS<xx>_<enq_server>

_EN = enserver.exe

Start_Program_02 = local $(DIR_EXECUTABLE)\$(_EN)

pf=$(DIR_PROFILE)\<sapsid>_(A)SCS<xx>_<enq_server>

■ Add the following lines:

_CP = sapcpe.exe

Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)

pf=$(DIR_PROFILE)\<sapsid>_REP<yy>_<rep_server>

_ER = enrepserver.exe

Start_Program_01 = local $(DIR_EXECUTABLE)\$(_ER)

pf=$(DIR_PROFILE)\<sapsid>_REP<yy>_<rep_server> NR=$(SCSID)

4 Make a copy of the <sapsid>_(A)SCS<xx>_<enq_server> instance profile, and
rename the copy as <sapsid>_REP<yy>_<rep_server>. This profile is the
instance profile for the Enqueue Replication server instance.

5 In the <sapsid>_REP<yy>_<rep_server> profile, do the following:

■ Change the values of the following parameters:

<yy>SAPSYSTEM
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<xx>SCSID

REP<yy>INSTANCE_NAME

\\<enq_server>\sapmnt\<sapsid>\SYS\globalDIR_GLOBAL

\\<enq_server>\sapmnt\<sapsid>\SYS\profileDIR_PROFILE

<drive>:\usr\sap\<sapsid>\REP<yy>\exeDIR_EXECUTABLE

\\<enq_server>\sapmnt\<sapsid>\SYS\exe\runDIR_CT_RUN

<enq_server>SAPGLOBALHOST

<rep_server>SAPLOCALHOST

<rep_server>SAPLOCALHOSTFULL

■ Remove the following lines:

rdisp/myname = <enq_server>_<sapsid>_<xx>

enque/server/replication = true

enque/server/threadcount = 1

ipc/shm_psize_34 = 0

enque/table_size = 4096

enque/deque_wait_answer = FALSE

enque/process_location = LOCAL

enque/encni/port = 3210

rdisp/enqname = $(rdisp/myname)

enque/snapshot_pck_ids = 100

rdisp/mshost=<enq_server>

rdisp/msserv = 3610

ms/server_port_0=PROT=HTTP, PORT=8110

■ Add the following lines:

enque/process_location = REMOTESA

enque/serverhost = <enq_server>

enque/serverport = 32$(SCSID)

enque/serverinst = $(SCSID)

enque/enrep/poll_interval = 0

enque/enrep/poll_timeout = 120

enque/enrep/inactive_action = sleep
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6 Create the following directory structure:

<drive>:\usr\sap\<sapsid>\REP<yy>\exe

<drive>:\usr\sap\<sapsid>\REP<yy>\log

<drive>:\usr\sap\<sapsid>\REP<yy>\data

<drive>:\usr\sap\<sapsid>\REP<yy>\work

7 From the (A)SCS instance directory, copy all binaries into the
<drive>:\usr\sap\<sapsid>\REP<yy>\exe directory.

8 In the<drive>:\usr\sap\<sapsid>\REP<yy>\exedirectory, createansapcpe.exe
list file. Name the list file as rep.lst.

The rep.lst filemust contain thenames of all the binary files in this directory.
The list file must also include an entry as rep.lst.

9 Use the sapstartsrv.exe command to create an SAP Windows Service for the
Enqueue Replication server instance.

Start the SAP instance for the Enqueue Replication server. Ensure that the
instance is running successfully.

The SAP instance is now ready for clustering.

See “Clustering an SAP instance” on page 62.

Clustering an SAP instance
This section describes the procedure for clustering an SAP instance.

This procedure involves the following steps:

■ Install the appropriate Windows Resource kit.

■ Add the %WINDIR%\SapCluster directory to the path variable of the user
sapsidadm.
In anSAPcluster installation, an additional directory,%WINDIR%\SapCluster,
is created under the systemdirectory. This directory contains all the SAP files
that the cluster nodes require. These files are database tools and program files
that the operating systemmonitors andSAPOsCol uses. They are independent
of the node that the SAP instance is running on.

■ Configure the node that hosts the SAP Central Service Instance ([A]SCS) or
Central Instance based on SAPGLOBALHOST parameter, and then configure
all other nodes that you want to cluster.
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Configuring the first node in the cluster
On the node in the cluster on which you installed SAP the first time, you must
perform the following steps:

■ Copy the required tools in to the SAPCluster directory.

■ Set the SAPService to manual.

■ Ensure that the SAPOsCol service is started from the SAPCluster directory.

■ Create the cluster service group for SAP instance.

These steps are explained in detail in the following sections.

To configure the first node in the cluster

1 Stop the SAP Central Services Instance or the Central instance based on
SAPGLOBALHOST.

2 Add the following lines in the start and instance profiles of the Central
instance:

DIR_INSTALL = <DISK>:\usr\sap\SID\SYS

DIR_INSTANCE = <DISK>:\usr\sap\<SAPSID>\<InstName>

SAPLOCALHOST = <InstanceVirtualHostName>

SAPLOCALHOSTFULL = <InstanceVirtualHostName>

3 In the start profile, make AUTOSTART as equal to 0.

4 Create the following directory:

%windir%\SapCluster

5 From the <disk>:\usr\sap\<SAPSID>\<InstName>\exe directory, copy the
following files into the %windir%\SapCluster directory:

sapevents.dll

sapntchk.exe

saposcol.exe

sapstartsrv.exe

6 Change the <sapsid>adm user environment as follows:

■ At the command prompt, type runas /profile

/user:<domain>\<sapsid>adm regedit.

■ In the Registry Editor screen, click HKEY_CURRENT_USER >
Environment.

■ Change the value of PATH to %PATH%;%windir%\SapCluster.
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7 Stop the following SAP services:

saposcol

SAP<SAPSID>_<No.>

8 Change the SAP service configuration by running the following command
from the command prompt:

sc config saposcol binPath= "%windir%\SapCluster\saposcol

service"

9 Configure the SAP<SAPSID>_<No.> service as follows:

■ At the command prompt, go to the %windir%\SapCluster\ directory.

■ Run the sapstartsrv.exe command.

■ In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary only in the Operation field.

■ Click OK.

■ Click Start > Run.

■ Enter services.msc in the Open field.

■ In the Services dialog box, right-click the SAP<SAPSID>_<No.> service,
and select Properties.

■ Select Manual in the Startup type field.

■ Click OK.

■ Quit the Services dialog box.

10 Create the following registry keys:

■ At the command prompt, type runas /profile

/user:<domain>\<sapsid>adm regedit.

■ In the Registry Editor screen, click HKEY_LOCAL_MACHINE > System
> CurrentControlSet > Services > EventLog > Application.

■ Create registry keys, SAPOsCol and SAP<SAPSID>_<No.>.

■ Assign the following values to the registry entries of SAPOsCol and
SAP<SAPSID>_<No.>:

Type: REG_DWORD

Data: 7

TypesSupported
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Type: REG_EXPAND_SZ

Data: %windir%\SapCluster\SAPEVENTS.DLL

EventMessageFile

Configuring all other nodes in the cluster
Activities on all other nodes in the cluster involve the following steps:

■ Create required users and groups.

■ Copy the required tools in the SAPCluster directory.

■ Set the system and user environment.

■ Enter the required port numbers in the Windows services files.

■ Create the SAPService and SAPOsCol services.

These steps are explained in detail in the following procedure.

To configure all other nodes in the cluster

1 Create local groups, SAP_<SAPSID>_LocalAdmin and SAP_LocalAdmin.

2 Add the SAP_<SAPSID>_GlobalAdmin domain group to these local groups.

3 Add the SAP_<SAPSID>_GlobalAdmin domain group to the local
Administrators group.

For details about creating and adding new local groups and users:

See “Creating and adding local groups and users” on page 72.

4 Click Start > Programs > Administrative Tools > Local Security Policy >
Local Policies > User Right Assignment.

5 Add the following privileges for the <sapsid>adm user.

Act as a part of the Operating System (SeTcbPrivilege)

Replace a process-level token (SeAssignPrimaryTokenPrivilege)

Adjust memory quotas for a process for Windows Server 2003

(SeIncreaseQuotaPrivilege)

6 Add the following privileges for the SAPService<SAPSID> user.

Log on as a Service (SeServiceLogonRight )

Access this computer from the network (SeNetworkLogonRight)

Deny Logon Locally and Deny Log on through Terminal Services

(SeDenyInteractiveLogOnRight)

7 Change the <sapsid>adm user environment as follows:
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■ At the command prompt, enter runas /profile
/user:<domain>\<sapsid>adm regedit.

■ In the Registry Editor dialog box, click HKEY_CURRENT_USER >
Environment.

■ Create the user environment.
See “Configuring the first node in the cluster” on page 63.

8 From the first node in the cluster, copy the following service entries for the
SAP instance, from the services file in the %windir%\system32\drivers\etc
directory to the corresponding services file on all other nodes in the cluster:

sapdp<No.> 32<No.>/tcp # SAP System Dispatcher Port

sapdp<No.>s 47<No.>/tcp # SAP System Dispatcher Security Port

sapgw<No.> 33<No.>/tcp # SAP System Gateway Port

sapgw<No.>s 48<No.>/tcp # SAP System Gateway Security Port

sapms<SAPSID> 36<No.>/tcp # SAP System Message Port

Typically, the value of <No.> is the value of InstID.

9 Move theServiceGroup from the first node to thenode that you are currently
configuring.

10 Create the following directory:

%windir%\SapCluster

11 From the <disk>:\usr\sap\<SAPSID>\<InstName>\exe directory, copy these
files into the %windir%\SapCluster directory.

sapevents.dll

sapntchk.exe

saposcol.exe

sapstartsrv.exe

12 Ensure that the <drive>:\usr\sap directory is sharedwith the names, sapmnt
and saploc.

See “Converting a local installation into a domain installation” on page 29.

13 Create the saposcol service by running the following command at the
command prompt:

sc create saposcol binPath= "%windir%\SapCluster\saposcol

service" start= auto obj= <domain>\SAPService<SAPSID> password=

<password_of_SAPService<SAPSID>> [DisplayName= SAPOsCol]
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14 Create the SAP<SAPSID>_<No.> service as follows:

■ At the command prompt, go to the
<drive>:\usr\sap\<SAPSID>\<InstName>\exe directory.

■ Run the sapstartsrv.exe command.

■ In the SAPService Install/Uninstall dialog box, enter the following values:

<SAPSID>SID

<InstanceNumber>NR

If SAPLOCALHOST=SAPGLOBALHOST, thevalue
is

<drive>:\usr\sap\<SAPSID>\profile\START_
<InstName>_<VirtualHostName>

Else, the value is

\\SAPGLOBALHOST\sapmnt\<SAPSID>\SYS\
profile\START_<InstName>_<VirtualHostName>

StartProfile

<domain>\SAPService<SAPSID>User

<SAPService<SAPSID> password>Password

manualStartup type

<domain>\<sapsid>admUse Environment of User

■ Click OK.

15 Reregister type library as follows:

■ At the command prompt, go to the %windir%\SapCluster directory.

■ Run the sapstartsrv.exe command.

■ In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field.

■ Click OK.

16 Create registry entries for the SAP<SAPSID>_<No.> and saposcol services.

See “Configuring the first node in the cluster” on page 63.

17 If an SAP Microsoft Management Console (MMC) is not configured on the
node, register SAP MMC using the following steps:

■ Access the <DVD>:\SAPINST\NT\<platform>\MMC directory.
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For SAP NetWeaver 04s, access the presentation DVD and go to the
\SAPINST\NT\<platform>\MMC directory.

■ Extract the SAPMMCU.SAR (Unicode) archive.

sapcar -xvf

"<DVD>:\SAPINST\NT\<platform>\MMC\SAPMMCU.SAR"

■ Copy the extracted files to the %windir%\system32 directory.
If you are unable to copy librfc32u.dll, stop the SAP<SAPSID>_<No.>
service, and try again.

■ Register all sapmmc*.dlls at the command prompt using this command
for each file.

%windir%\system32\regsvr32 <dll_file_name>

■ Create a desktop shortcut for %windir%\system32\sapmmc.msc.

Clustering an SAP Add-In instance

Note: This section is not applicable for SAP NetWeaver 04s.

For anSAPAdd-In system, clustering theCentral instance and theEnqueue servers
in different ServiceGroups is not possible. The path names and virtual hostnames
are firmly connected to various points in the J2EE engine and therefore, youmust
not change the instance names and the virtual hostnames.

But when you cluster the Central instance and the Enqueue servers in the same
Service Group, the down time increases whenever the Enqueue server fails. This
increase is because the Central instance takes more time to shut down or restart.
Another drawback is that whenever the Enqueue server fails, all user sessions
connected to the Central instance are lost.

To resolve this issue, configure the Central instance outside the cluster
environment. If you want to conduct SDM deployment tasks, bring the Central
instance onlinemanually, on the samenode onwhich the ServiceGroup including
the Enqueue servers is online. For all user operations, you can additionally install
and use a dedicated Dialog instance.
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Note: If you are clustering the Central instance, Symantec recommends that you
cluster the Central instance, Java Central Services instance, andABAPStandalone
Enqueue server instance in the same Service Group. Symantec also recommends
that you cluster the EnqueueReplication servers for ABAP and Java for anAdd-In
system in a single ServiceGroup. Such a high availability configuration facilitates
failover to another node in the cluster if a fault occurs.

For clustering this instance:

See “Clustering an SAP instance” on page 62.

Creating and adding domain groups and users
If you donot have domain administrator rights, you can perform the SAP instance
installation and configuration as a domain user who is a member of the local
administrator group.

User accounts
TheSAPInst tool creates the following accounts for the SAP systemadministrator:

This user account is the SAP system administrator account. This
account enables interactive administration of the system.

<sapsid>adm

This user account is required to start the SAP system.This account
has the local user right to log on as a service.

The advantage of setting up this additional account is that this
account does not allow interactive logon. Therefore, abuse of the
account can be prevented. You need not set an expiry date for the
password and you can skip selecting the User must change
password at next logon option.

SAPService<SID>

Groups
The SAPInst tool creates the following groups during domain installation:

■ SAP_<SAPSID>_GlobalAdmin
This global group is a domain level SAP administration group for organizing
SAP system administrators. This global group groups together the users at
the domain level so that they can be placed in appropriate local groups.

■ SAP_<SAPSID>_LocalAdmin
Local groups are created and maintained on an application server. A local
group has rights only to the system on which the group is located.
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The system on which the local group is located is part of a particular domain.
The local group can contain users and global groups from this domain.

■ SAP_LocalAdmin
Though this group is created on all hosts, creating this group on the transport
host is necessary. Members of this group have full control over the transport
directory, \usr\sap\trans.This directoryallows transports to takeplacebetween
systems.
The SAP_<SAPSID>_GlobalAdmin groups of all the SAP systems that are part
of the transport infrastructure are added to the SAP_LocalAdmin group.
Therefore, the <sapsid>adm and SAPService<SAPSID> users of all systems in
the transport infrastructure aremembers of theSAP_LocalAdmingroup.These
users have the rights necessary to initiate and execute transports.

Adding groups
This section describes the procedure to add new domain groups and users. You
can perform this procedure as a domain administrator only.

To create the SAP_<SAPSID>_GlobalAdmin Global group

1 Log in as a domain administrator.

2 Click Start > Programs > Administrative Tools > Active Directory Users
and Computers.

If you are unable to find the following options:

■ Click Start > Run.

■ Enter mmc in the Open field.

■ In the Console window, click File > Add/Remove Snap-in.

■ In the Add/Remove Snap-in dialog box, click Add.

■ In the Add Standalone Snap-in dialog box, select Active Directory Users
and Computers.

■ Click Add.

■ Click OK.

3 In the Active Directory Users and Computers dialog box, right-click Users,
and select New > Group.
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4 In the New Object - Group dialog box, enter the following values:

SAP_<SAPSID>_GlobalAdmin

Specify this value using the exact and correct uppercase and
lowercase.

Group Name

GlobalGroup scope

SecurityGroup type

5 Click OK.

To create SAP system users, <sapsid>adm and SAPService<SAPSID>

1 In the Active Directory Users and Computers dialog box, right-click Users,
and select New > User.

2 In the New Object - User dialog box, enter the following values for
<sapsid>adm:

NAFirst name

NAInitials

NALast name

<sapsid>admFull name

<sapsid>admUser logon name

3 In the New Object - User dialog box, enter the following values for
SAPService<SAPSID>:

NAFirst name

NAInitials

NALast name

SAPService<SAPSID>Full name

SAPService<SAPSID>User logon name

4 Click Next.

5 Enter the password and confirm the password.
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6 Select Password never expires.

Ensure that no other option is selected.

7 Click Next.

8 Click Finish.

To add the <sapsid>adm user to the SAP_<SAPSID>_GlobalAdmin Group

1 In the Active Directory Users and Computers dialog box, double-click
<sapsid>adm under Users.

2 In the <sapsid>adm Properties dialog box, click Member > Add.

3 In the Select Groups dialog box, select SAP_<SAPSID>_GlobalAdmin.

4 Click Add.

By default, this user is also a member of the Domain Users group.

5 Click OK twice.

To add the SAPService<SAPSID> user to the SAP_<SAPSID>_GlobalAdmin Group

1 In the Active Directory Users and Computers dialog box, double-click
SAPService<SAPSID> under Users.

2 In the SAPService<SAPSID> dialog box, click Member > Add.

3 In the Select Groups dialog box, select SAP_<SAPSID>_GlobalAdmin.

4 Click Add. SAP_<SAPSID>_GlobalAdmin appears in the Member of list.

5 This user must not be a member of the Domain Users group.

Remove the user from the Domain Users group as follows:

■ From the Member of list, select SAP_<SAPSID>_GlobalAdmin.

■ Select Set Primary Group.

■ Select Domain Users.

■ Click Remove to delete the Domain Users group from the Member of list.

6 Click OK.

7 Exit the Active Directory Users and Computers dialog box.

Creating and adding local groups and users
This section describes the procedure to add new local groups and users.

Assume that you are adding a local group, SAP_<SAPSID>_LocalAdmin.
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To create a local group

1 ClickStart>ControlPanel>Administrativetools>ComputerManagement.

2 In the Computer Management dialog box, select Local Users and Groups.

3 Right-click Group, and select New Group.

4 In theNewGroupdialog box, enter SAP_<SAPSID>_LocalAdmin in theGroup
name field.

5 Click Add.

6 In the Select Users, Computers, or Groups dialog box, enter
<domain>\SAP_<SAPSID>_GlobalAdmin in the Object names field.

7 Click OK in the Select Users, Computers, or Groups dialog box.

SAP_<SAPSID>_LocalAdmin appears in the New Group dialog box.

8 Click OK in the New Group dialog box.

To add a domain group to a local group

1 ClickStart>ControlPanel>Administrativetools>ComputerManagement.

Assume that you are adding the domain group, SAP_<SAPSID>_GlobalAdmin
to the local Administrators group.

2 In the Computer Management Console, select Local Users and Groups >
Groups.

3 In the right panel, double-click Administrators.

4 In the Administrators Properties dialog box, click Add.

5 In the Select Users, Computers, or Groups dialog box, enter
<domain>\SAP_<SAPSID>_GlobalAdmin in the Object names field.

6 Click OK in the Select Users, Computers, or Groups dialog box.

7 Click OK in the Administrators Properties dialog box.

Creating sapmnt and saploc share directories
Ensure that the sapmnt and saploc directories are shared, and are accessible by
the SAP system Administrator.

To create the sapmnt and saploc share directories on Windows Server 2003

1 Right-click the drive:\usr\sap directory, and select Properties.

2 In the Properties dialog box, click the Sharing tab.

3 Click Share this folder.
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4 Enter sapmnt in the Share name field.

5 Click Permissions.

6 In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt directory.

7 Click OK in the Permissions for sapmnt dialog box.

8 In the Properties dialog box, click New Share.

9 In the New Share dialog box, enter saploc in the Share name field.

10 Click OK in the New Share dialog box.

11 Click Permissions.

12 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

13 Click OK in the Permissions for saploc dialog box.

14 Click OK in the Properties dialog box.

To create the sapmnt and saploc share directories on Windows Server 2008

1 Right-click the drive:\usr\sap directory, and select properties.

2 On the Properties dialog box, click the Sharing tab.

3 Click Advanced Sharing.

4 Select Share this folder option.

5 Enter sapmnt in the Share name field.

6 Click Permissions.

7 In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt directory.

8 Click OK in the Permissions for sapmnt dialog box.

9 In the Properties dialog box, click Advanced Sharing.

10 On the Advanced Sharing dialog box, click Add.

11 On the New Share dialog box, enter saploc in the Share name field.

12 Click OK in the New Share dialog box.

13 Click Permissions.

14 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

15 Click OK in the Permissions for saploc dialog box.

16 Click OK in the New Share dialog box.
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17 Click OK in the Advanced Sharing dialog box.

18 Click Close in the Properties dialog box.

Configuring theSAPsystemsonWindowsServer 2008
TheFile Share feature functions differently onWindowsServer 2008, as compared
toWindows Server 2003. OnWindows Server 2008, you can only access file shares
pointing to local disks with the physical computer name. To be able to define file
shares pointing to shared disks, a “client access point” (one IP address associated
with onenetworkname cluster resource)must already exist in the failover cluster
service group to which the shared disk belongs. Since you can only access file
shares pointing to shared disks with the network name that belongs to the same
failover cluster service group, you can create multiple file shares with the same
file share name (for example, sapmnt) in a failover cluster environment, assuming
the file shares belong to different cluster service groups.

Figure 2-1 shows a typical SAP system installation on a Windows Server 2008
system under VCS environment.

Figure 2-1 Typical SAP system installation (using multiple sapmnt file shares)
on a Windows Server 2008 system under VCS environment

75Installing and configuring the SAP NetWeaver for high availability
Configuring the SAP systems on Windows Server 2008



For sample service group configurations on Windows Server 2008,

See “Sample service group configurations for SAP system on Windows Server
2008” on page 127.
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Installing, upgrading, and
removing the agent for SAP
NetWeaver

This chapter includes the following topics:

■ Before you install the agent for SAP NetWeaver

■ Installing the VCS agent for SAP NetWeaver

■ Removing the VCS agent for SAP NetWeaver

■ Upgrading the agent for SAP NetWeaver

Before you install the agent for SAP NetWeaver
Youmust install the agent on all the systems that will host an SAP Service Group.

Ensure that you meet the following prerequisites before installing the agent for
SAP NetWeaver:

■ Install and configure Veritas Cluster Server.

■ Remove any previous version of this agent.
See “Removing the VCS agent for SAP NetWeaver” on page 78.

Installing the VCS agent for SAP NetWeaver

Note: Ensure that you have uninstalled the previous version of this agent, if
installed.
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Also note that the agents for both, SAPNetWeaver and SAPWebAS are combined
in a single package. Thus, if you install either of the agent, the other agent gets
installed by default.

To install the VCS agent for SAP NetWeaver

1 Log on to any node in the cluster.

Ensure that the logged on user has the domain administrative privileges.

2 Download the Agent Pack from the Symantec Operations Readiness Tools
(SORT) site: https://sort.symantec.com/agents.

You can download the complete Agent Pack tar file or the individual agent
tar file.

3 Uncompress the file to a temporary location.

4 If you downloaded the complete Agent Pack tar file, navigate to the directory
containing the package for the platform running in your environment.

cd1\windows\w2k3IA64\vcs\application\sapnw_agent\
vcs_version\version_agent\Pkgs

Windows 2003
(IA64)

cd1\windows\w2k3x64\vcs\application\sapnw_agent\
vcs_version\version_agent\Pkgs

Windows 2003
(x64)

cd1\windows\w2k8x64\vcs\application\sapnw_agent\
vcs_version\version_agent\Pkgs

Windows 2008
(x64)

5 Double-click vrtsvcssap.msi.

6 Follow the instructions that the install program provides, to complete the
installation of Veritas agent for SAP server.

Removing the VCS agent for SAP NetWeaver
Perform the following procedure to uninstall the agent for SAP NetWeaver from
a cluster. Perform these steps while the cluster is active.

Note: The agent for SAP NetWeaver and SAP WebAS are combined in a single
package. Thus, removing one agent package will remove the other by default.
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To uninstall the VCS agent for SAP NetWeaver

1 Ensure that all clustered SAP resources are offline.

2 From the cluster, remove all the resources that use the agents for SAP
NetWeaver.

3 Perform the following steps on each node from which you want to uninstall
the agent. Ensure that you have a user with administrative privileges.

■ Click Start > Settings > Control Panel.

■ On Windows 2003: Navigate to Add/Remove Programs■

■ On Windows 2008 : Navigate to Programs and Features

■ OnWindows 2008R2 :Navigate toPrograms>ProgramsandFeatures

■ From the list of programs, select vrtsvcssap.msi.

4 Click Change/Remove.

5 Follow the instructions that the uninstall program provides, to complete the
uninstallation of the agents for SAP NetWeaver.

Upgrading the agent for SAP NetWeaver
Perform the following steps to upgrade the agent with minimal disruption, in a
VCS environment.

To upgrade the agent in a VCS environment

1 Login as domain administrator.

2 Verify that your path is drive:\Program Files\Veritas\Cluster Server\bin

3 Persistently freeze all the service groups that host the application.

C:\> hagrp –freeze GroupName -persistent

4 Stop the cluster services forcibly.

C:\> hastop -all –force

5 Ensure that the agent operations are stopped on all the nodes.

6 Take a back up of the main.cf and types.cf

C:\> copy drive:\> Program Files\Veritas\Cluster

Server\conf\config\main.cf drive:\>backup\main.cf

C:\> copy drive:\> Program Files\Veritas\Cluster

Server\conf\config\types.cf drive:\>backup\types.cf
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7 Uninstall the agent package from all the nodes.

See “Removing the VCS agent for SAP NetWeaver” on page 78.

8 Install the new agent on all the nodes.

See “Installing the VCS agent for SAP NetWeaver” on page 77.

9 Navigate todrive:\>ProgramFiles\Veritas\ClusterServer\conf\config\types.cf
file and verify if any duplicate type definitions exists for Weblogic on all the
nodes.

If duplicate type definitions exist, remove old type definition from types.cf
file and save the file.

Note:To identify the old type definition, compare the new type definition file
with the old (backed up) types.cf file.

10 Check for the changes in the resource values required, if any, due to the new
agent types definition.

Note: To note the list of changed attributes, compare the new type definition
file with the old type definition file.

11 Start VCS on all nodes in the cluster.

C:\> hastart

12 Start the agent on all nodes, if not started.

C:\> haagent -start SAPNW04 -sys SystemName

Optionally, start the SAPWebAS agent,

C:\> haagent -start SAPWebAS -sys SystemName

13 Unfreeze the service groups once all the resources come to an online steady
state.

C:\> hagrp -unfreeze GroupName -persistent
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Configuring the agent for
SAP NetWeaver

This chapter includes the following topics:

■ About configuring the agent for SAP NetWeaver

■ Agent attributes for SAP NetWeaver

■ Setting the SAPMonHome attribute

■ Configuring the execution period for agent functions

■ Executing a custom monitor program

About configuring the agent for SAP NetWeaver
To provide high availability for SAP components in the VCS environment, you
must first configure the VCS resources of type SAPNW04.

After installing the Agents for SAPNetWeaver, you can create and configure SAP
resources. Before you configure a resource, review the attributes table that
describes the SAPNW04 resource type and its attribute definitions.

See “Agent attributes for SAP NetWeaver” on page 81.

Agent attributes for SAP NetWeaver
Table 4-1 shows the required attributes for configuring an SAP instance.
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Table 4-1 Required Attributes

DescriptionRequired attributes

Name of the VCS resource that is running the Standalone Enqueue server instance
or SAP Central Services. The Enqueue Replication server instance uses this attribute
to query the state of the resource that is running the Standalone Enqueue server
instance, whenever a fault occurs.

The preonline trigger script also uses this attribute in case of a Standalone Enqueue
server fail over. The script uses this attribute to identify the appropriate node on
which the Enqueue Replication server instance is running.

Type and dimension: string-scalar

Default: ""

Example: SAPEC4ASCS_srv

EnqSrvResName

The amount of time reserved for graceful clean-up activities that the clean operation
performs on an SAP instance, before returning control to the VCS engine.

See “Configuring the execution period for agent functions” on page 88.

Type and dimension: integer-scalar

Default: 10

Example: 20

EPProgramTimeout

Uniquely identifies an SAP server instance, along with the SAPSID attribute. The
last two characters of this attribute specify the value of the InstID attribute. The
InstID and SAPSID attributes together uniquely identify an SAP instance.

Some examples include the following:

■ DVEBMGS00: SAP BASIS Central instance

■ DVBGS02 : SAP BASIS Central instance minus Enqueue and Message servers

■ ASCS03: SAP ABAP Standalone Enqueue server

■ REP04: SAP ABAP Enqueue Replication server

■ D05: SAP ABAP Dialog instance

■ JC06: SAP Java Central instance

■ SCS07: SAP Java Central Services instance

■ J08: SAP Java Dialog instance

■ ERS10: SAP Enqueue Replication server

See “Uniquely identifying SAP server instances” on page 25.

Type and dimension: string-scalar

Example: DVEBMGS00

Default: ""

InstName
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Table 4-1 Required Attributes (continued)

DescriptionRequired attributes

Full path to the instance profile of the SAP server instance. SAP Java instances,
Enqueue Replication server instances, and Standalone Enqueue server instances use
this attribute during second-level monitoring.

Typically, the instance profile is located in the <drive>:\usr\sap\SAPSID\SYS\profile
directory.The formatof theprofilename isSAPSID_InstName_VIRTUAL_HOSTNAME.
Path names following the Unified Naming Convention (UNC) are also valid for this
attribute.

Type and dimension: string-scalar

Default: ""

Example 1: c:\usr\sap\EP1\SYS\profile\EP1_SCS02_SAPEP1SCS

Example 2: \\SAPEP1SCS\sapmnt\EP1\SYS\profile\EP1_REP03_SAPEP1REP

Example 3: \\SAPEP1SCS\sapmnt\EP1\SYS\profile\EP1_JC00_SAPEP1CI

InstProfile

SAP server instance type. Valid values include the following:

■ CENTRAL: SAP Central instance

■ DIALOG: SAP Dialog instance

■ ENQUEUE: SAP Standalone Enqueue server instance

■ ENQREP: SAP Enqueue Replication server instance

■ AENQUEUE: SAP Standalone Enqueue server instance Add-In (ABAP)

■ AENQREP: SAP Enqueue Replication server instance Add-In (ABAP)

■ JENQUEUE: SAP Central Services instance Add-In (Java)

■ JENQREP: SAP Enqueue Replication server instance Add-In (Java)

■ MDM: SAP MDM instance

Type and dimension: string-scalar

Default: CENTRAL

Example: DIALOG

InstType

The list of SAP processes that themonitor functionmustmonitor during a first-level
check of an SAP instance.

See “Monitoring an SAP instance” on page 26.

Type and dimension: vector

Default: ""

Example: disp+work.exe msg_server.exe

ProcMon
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Table 4-1 Required Attributes (continued)

DescriptionRequired attributes

The logging detail performedby theAgent for SAPNetWeaver for the resource. Valid
values include the following:

INFO: Logs error messages.

TRACE: Logs error and trace messages. TRACE is very verbose and should only be
used during initial configuration or for troubleshooting and diagnostic operations.

Type and dimension: string-scalar

Default: INFO

Example: TRACE

ResLogLevel

Windows user name used to start the SAP instance. This user must be dedicated to
all the SAP instances within an SAP system. The format is sapsidadm.

Note: Do not include the domain name when specifying this attribute. Use the
SAPAdminDomain attribute to specify domain information.

Type and dimension: string-scalar

Default: ""

Example: ec4adm

SAPAdmin

Windows domain name to which the SAPAdmin user belongs.

Note: If SAPAdmindoes not belong to aWindows domain, use the cluster localization
settings to specify the local computer name for each system.

Type and dimension: string-scalar

Default: ""

Example: VRTSGPS

SAPAdminDomain

Password for the SAPAdmin user.

Use the vcsencrypt -agent command to encrypt the password. If you are using
the VCS GUI, the GUI automatically encrypts the password.

Type and dimension: string-scalar

Default: ""

Example: vxfgh28skbsj

SAPAdminPassword
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Table 4-1 Required Attributes (continued)

DescriptionRequired attributes

Virtual IP host name (LANMAN name) under which the SAP instance is to run.

Type and dimension: string-scalar

Default: ""

Example: sap04smscsaw

SAPHost

The absolute path to the SAPbase directory. This attribute is used to locate programs
that the Agent for SAP NetWeaver uses for start, stop, and clean functions.

Type and dimension: string-scalar

Default: ""

Example 1: c:\usr\sap\EC4\SYS\exe\run

Example 2: c:\usr\sap\EC4\ASCS01\exe

SAPHome

The directory that defines the location of the sapinfo.exe, jcmon.exe, or ensmon.exe
commands. The agent for SAP NetWeaver uses these commands for second-level
monitoring.

This functionality is not a part of the base SAP installation. Hence, the value of this
attribute may be different from the SAPHome attribute.

See “Setting the SAPMonHome attribute” on page 87.

Type and dimension: string-scalar

Default: ""

Example: C:\usr\sap\sapinfo\rfcsdk\bin

SAPMonHome

Windows user name used to start the SAPWindows service for an SAPSID. This user
must be dedicated to all the SAP services under one SAP system, and must not be
used by any other SAP service or instance under a different SAP system, even in the
same cluster.

Note: Do not include the domain name in the value for this attribute. Use the
SAPAdminDomain attribute to specify domain information.

Type and dimension: string-scalar

Default: ""

Example: SAPServiceEC4

SAPServiceUser
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Table 4-1 Required Attributes (continued)

DescriptionRequired attributes

SAP system name. This attribute starts with an alphabetic character and is exactly
3 characters in length. Ensure that the alphabetic characters used in this attribute
are in uppercase only. SAPSID is defined during the SAP installation.

See “Uniquely identifying SAP server instances” on page 25.

Type and dimension: string-scalar

Default: ""

Example: EC4

SAPSID

Table 4-2 shows the optional attributes for configuring an SAP instance.

Table 4-2 Optional attributes

DescriptionOptional attributes

The full pathname and command-line arguments for an externally providedmonitor
program.

See “Executing a custom monitor program” on page 88.

Type and dimension: string-scalar

Default: ""

Example 1: <drive>:\usr\sap\EC4\ASCS00\work\myMonitor.exe

Example 2: <drive>:\usr\sap\EC4\ASCS00\work\myMonitor.exe arg1 arg2

MonitorProgram

Used to enable second-level monitoring. Second-level monitoring is a deeper, more
thorough state check of the SAP instance. The numeric value specifies how often the
monitoring routines must run. 0 means never run the second-level monitoring
routines, 1 means run routines every monitor interval, 2 means run routines every
second monitor interval, and so on.

Based on the type of installation, the agent uses the SAP supplied sapinfo.exe,
jcmon.exe, or ensmon.exe commands to perform second-level monitoring.

Note: Exercise caution while setting SecondLevelMonitor to large numbers. For
example, if the MonitorInterval is set to 60 seconds and the SecondLevelMonitor is
set to 100, then sapinfo.exe is executed every 100minutes, whichmay not be as often
as intended. For maximum flexibility, no upper limit is defined for
SecondLevelMonitor.

Type and dimension: integer-scalar

Default: 0

Example: 1

SecondLevelMonitor
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Setting the SAPMonHome attribute
The SAPMonHome attribute contains the absolute path to the directory that
contains the binary used for second level monitoring process.

The binaries that are usedduring second levelmonitoring for different installation
types and SAP instances are as follows:

■ For ABAP: sapinfo
sapinfo is not a standard binary shipped by SAP with installation media. You
need to download the latest rfcsdk kit from the following site:
http://service.sap.com/swdc -> Support Packages and Patches -> Entry by
Application Group -> Additional Components
Formore information on selecting the rightRFCSDK for your SAPapplication,
refer to SAP notes 1005832, 825494 and 413708.
Copy the sapinfo binary and theneeded libraries, if any, to SAP Instance specific
directory drive\usr\sap\SAPSID\InstName\exe
Also, ensure that the sapinfo binaries and the libraries are copied to
\\SAPGLOBALHOST\sapmnt\SAPSID\SYS\exe\run and the names of the
binaries and libraries are listed in the instance specific sapcpe binary list.

■ For Java: jcmon

■ For Add-In (ABAP + Java): sapinfo, jcmon

■ For Enqueue and Enqueue Replication Server: ensmon

Table 4-3 shows recommended values for the SAPMonHome attribute.

Table 4-3 Recommended values for SAPMonHome attribute

Value of the SAPMonHome
attribute

FormatSAP installation type and instance

drive\usr\sap\SAPSID\SYS\exe\runUnicode and non-UnicodeSAP ABAP

For all instances

drive\usr\sap\SAPSID\SYS\exe\runUnicodeSAP Java

For all instances

drive\usr\sap\SAPSID\SYS\exe\runUnicode and non-UnicodeSAP Java Add-In

When InstType is equal to CENTRAL,
DIALOG, AENQUEUE, or AENQREP

drive\usr\sap\SAPSID\SYS\exe\runUUnicode and non-UnicodeSAP Java Add-In

When InstType is equal to JENQUEUE or
JENQREP
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Configuring the execution period for agent functions
An agent function is allocated an execution period using the respective time-out
attributes: OnlineTimeout, OfflineTimeout, MonitorTimeout, and CleanTimeout.

If an agent function executes a program, for example sapinfo.exe, the program
must execute within the allocated execution period. If the program is unable to
execute within the allocated period, the agent function cancels and terminates
the execution of the program.

The agent function requires an allocated time to gracefully exit and terminate a
program.TheEPProgramTimeout attribute specifies the period inwhich the agent
function can cancel a running program.

For example, if EPProgramTimeout is set to 10 and MonitorTimeout is set to 60,
themonitor function cancels aprogramexecution if theprogramdoesnot complete
within 50 seconds of the start of the monitor function.

Executing a custom monitor program
The monitor function executes a custom monitor program to perform a
user-defined SAP instance server state check.

The monitor function executes the MonitorProgram if the following conditions
are true:

■ The MonitorProgram attribute value is set to a valid executable program.

■ The first level process check indicates that the SAP server instance is online.

■ The SecondLevelMonitor attribute is either set to 0 (false), or
SecondLevelMonitor is set to 1 (true) and the second-level check indicates that
the SAP server instance is online.

This feature allows cluster administrators to define custom programs that can
further determine the state of the SAP server.

The monitor operation interprets the program exit code as follows:

SAP server instance is ONLINE110 or 0

SAP server instance is OFFLINE100 or 1

SAP server instance is UNKNOWN99

SAP server instance is UNKNOWNAny other value
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To ensure that the custom monitor program is always available to the agent
application, Symantec recommends storing the file in a directory that is available
on an online SAP system.
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Configuring the service
groups for SAP server

This chapter includes the following topics:

■ About configuring service groups for SAP NetWeaver

■ Before configuring the service groups for SAP server

■ Configuring service groups for SAP NetWeaver

■ About the configuration process

■ Configuring the VCS preonline trigger

About configuring service groups for SAPNetWeaver
Configuring the SAP NetWeaver service group involves creating the SAP service
group, its resources, and defining attribute values for the configured resources.
You must have administrator privileges to create and configure a service group.

You can configure the service groups using one of the following:

■ The Cluster Manager (Java console)

■ Veritas Operations Manager

■ The command-line

See “Configuring service groups for SAP NetWeaver” on page 92.

Before configuring the service groups for SAP server
Before youconfigure theSAPserver service group, youmustperformthe following:
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■ Verify that VCS is installed and configured on all nodes in the cluster where
you will configure the service group.
Refer to Veritas Storage Foundation™ and High Availability Solutions
Installation and Upgrade Guide for more information on installing and
configuring VCS.

■ Verify that SAP NetWeaver 7.10 is installed and configured identically on all
nodes in the cluster.
See “About installing SAP NetWeaver for high availability” on page 28.
See “About configuring SAP NetWeaver for high availability” on page 28.

■ Verify that the Veritas agent for SAP server is installed on all nodes in the
cluster.
See “Installing the VCS agent for SAP NetWeaver” on page 77.

Configuring service groups for SAP NetWeaver
While setting up a cluster, youmust always ensure that the cluster has some spare
capacity to handle the SAP NetWeaver failover scenarios. For example, in case of
a backend database failure, the cluster must be able to run another database
instance in conjunction with other running applications.

See Veritas Storage Foundation™ andHigh Availability Solutions Installation and
Upgrade Guide

The cluster should be able to provide application failover by encapsulating the
resources required for an application into a service group. A service group is a
virtualized application that can switch between the cluster nodes. It contains a
set of dependent resources, such as disk groups, disk volumes, file systems, IP
addresses, NIC cards, and dependent application processes. It also includes logic
about the dependencies between the application components.

These service groups should thus be configured such that the cluster can start,
stop, monitor, and switch the service groups between the nodes, depending upon
the server faults or resource faults. An administrator should also be proactively
able to move a service group between cluster nodes to perform preventative
maintenance or apply patches.
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Perform the following steps to add a service group for SAP NetWeaver

1 Change the cluster configuration to read/write mode.

C:\> haconf -makerw

2 Create a service group for SAP NetWeaver.

C:\> hagrp -add SAP70-ERPASCS

For more details refer to, Veritas Cluster Server Administrator's Guide

3 Modify the SystemList attribute for the group, to add systems.

C:\> hagrp -modify SAP70-ERPASCS SystemList vcswin74 0 vcswin75

1

4 Create resources forNIC, IP, Lanman,VMDgandMountV in the service group.

C:\> hares -add SAP70-ERPASCS_nic NIC SAP70-ERPASCS

C:\> hares -add SAP70-ERPASCS_ip IP SAP70-ERPASCS

C:\> hares -add SAP70-ERPASCS_lanman Lanman SAP70-ERPASCS

C:\> hares -add SAP70-ERPASCS_mnt MountV SAP70-ERPASCS

C:\> hares -add SAP70-ERPASCS_vmdg VMDg SAP70-ERPASCS

For more details on creating and modifying resource attributes for NIC, IP,
Lanman, VMDg and MountV refer to, Veritas Cluster Server Bundled Agents
Reference Guide.

5 Create links between the resources.

C:\> hares -link SAP70-ERPASCS_ip SAP70-ERPASCS_nic

C:\> hares -link SAP70-ERPASCS_lanman SAP70-ERPASCS_ip

C:\> hares -link SAP70-ERPASCS_mnt SAP70-ERPASCS_vmdg

6 Create SAPNW04 resource for SAP Netweaver.

C:\> hares -add SAP70-ERPASCS_ascs SAPNW04 SAP70-ERPASCS

Based on the SAP instance you are clustering,modify the resource attributes.

For more information on agent attributes,

See “Agent attributes for SAP NetWeaver” on page 81.

7 Create resource dependencies for SAPNW04 resource.

The SAPNW04 resource depends on the Lanman and MountV resources.

C:\> hares -link SAP70-ERPASCS_ascs SAP70-ERPASCS_lanman

C:\> hares -link SAP70-ERPASCS_ascs SAP70-ERPASCS_mnt
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8 Verify the final resource dependencies for SAP server group.

Group Parent Child

SAP70-ERPASCS SAP70-ERPASCS_ascs SAP70-ERPASCS_lanman

SAP70-ERPASCS SAP70-ERPASCS_ascs SAP70-ERPASCS_mnt

SAP70-ERPASCS SAP70-ERPASCS_ip SAP70-ERPASCS_nic

SAP70-ERPASCS SAP70-ERPASCS_lanman SAP70-ERPASCS_ip

SAP70-ERPASCS SAP70-ERPASCS_mnt SAP70-ERPASCS_vmdg

9 Save the cluster configuration.

C:\> haconf -dump -makero

About the configuration process
While various methods and procedures can be used to install and configure the
service groups in an SAP server, Symantec recommends the following general
process:

■ Allocate shared disk resource for the SAP node
Symantec recommends installing eachSAPnode to be clustered on a separate,
dedicated shared disk resource (e.g. LUN). Work with the appropriate
administrative group in your organization to obtain a shared disk resource
for the SAP node.

■ Create disk group, volumes, and a file system
A disk group contains volumes and file system (mount resource). All SAP R/3
directories are placed in these volumes.
Create a disk group, volumes, and a file systemsusing the shared disk resources
allocated for the SAP node.
You can use the Veritas Volume Manager to create the disk group, volumes,
and file system.

Obtaining a dedicated virtual IP address and host name
Obtain a dedicated virtual IP address and host name for the SAP node IP network
configuration. The SAP instance uses this network address and host name
exclusively, and is regardless of the system in the cluster running the instance.

Note: Ensure that you map the virtual IPs in the DNS, or the hosts file on each
system.
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Creating cluster service group and supporting resources
Create a cluster service group that contains the resources supporting the SAP
node. Create appropriate cluster resources.

Create links to place the shared disk andnetworking objects, thatwere previously
placed under the cluster control.

Test the Service Group configuration by placing it online.

Figure 5-1 shows a sample service group configuration.

Figure 5-1 Sample service group configuration
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Installing the software for the SAP instance
See “Setting up SAP systems for clustering” on page 29.

Ensure that SAP runs successfully on all nodes of the cluster before placing the
SAP instance under the cluster control.

Placing the SAP instance under cluster control
After the SAP installation is complete, create a cluster resource using the agent
for SAP NetWeaver.
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Figure 5-2 shows a service group in which the SAP instance is under the cluster
control.

Figure 5-2 SAP instance under cluster control
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Configuring the VCS preonline trigger
Thebehavior of theSAPStandaloneEnqueueandSAPEnqueueReplication servers
in a clustered environment has the following requisites:

■ If a Standalone Enqueue server instance fails, the server must fail over to the
node where the Enqueue Replication server instance is online.
The Standalone Enqueue server instance examines the shared memory, and
locates a replicated copy of the lock state table. The instance uses the replicated
copy to initialize the original lock state table.
After the Standalone Enqueue server instance initiates its internal lock buffer,
theReplication server instancemust go downandmust switch to another node
in the cluster.

■ If the Enqueue Replication server instance fails, the instance must fail over
to such a node in the cluster that does not have an Enqueue server instance
in ONLINE state.
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To facilitate proper failover behavior, you must configure the VCS preonline
trigger. The VCS preonline trigger calls an external preonline trigger utility,
sapnw04preonline.exe.The initiatedpreonline triggerperforms the stepsnecessary
for correct failover behavior of the Enqueue servers. The sapnw04preonline.exe
utility is located in the %VCS_HOME%\bin\SAPNW04 directory.

To configure the VCS preonline trigger script, perform the following steps:

Step 1: Navigate to the %VCS_HOME%\bin\Trigger directory.

Step 2: Add the following lines to the preonline file:

If you are configuring the preonline file for the first time, this file may not exist.
You can thus skip this step.

#--------------------------------------------------------------

# Start sapnw04 preonline trigger.

#--------------------------------------------------------------

# Perl preonline.pl <system> <group> <whyonlining>

<systemwheregroupfaulted>

my $system = $ARGV[0];

my $group = $ARGV[1];

my $whyonlining = $ARGV[2];

my $systemwheregroupfaulted = undef;

my $sArgs = join(' ', @ARGV);

VCSAG_LOG_MSG("I", "Arguments [$sArgs]", 15041);

if(defined $ARGV[3]) {

$systemwheregroupfaulted = $ARGV[3];

}

$SAPPreOnlineTrigger =

sprintf("%s\\bin\\SAPNW04\\sapnw04preonline.exe", $vcs_home);

VCSAG_LOG_MSG("I", "The trigger command is

[$SAPPreOnlineTrigger]", 15041);

if(defined $systemwheregroupfaulted)

{

VCSAG_LOG_MSG("I", "The group is faulted on syetem =

[$systemwheregroupfaulted]", 15042);

$CMD = sprintf("\"%s\" %s %s %s %s", $SAPPreOnlineTrigger,

$system, $group, $whyonlining, $systemwheregroupfaulted);

}

else {

$CMD = sprintf("\"%s\" %s %s %s", $SAPPreOnlineTrigger, $system,

$group, $whyonlining);

}

system($CMD);

my $exit_value = $? >> 8;
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VCSAG_LOG_MSG("I", "The exit code from the trigger:

[$exit_value].", 15046, $exit_value);

if($exit_value == 0) {

VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP excuted

succesfully.", 15046);

exit;}elsif($exit_value == 1) {

VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP FAILED.",

15047);

exit;

}

else {

VCSAG_LOG_MSG("I", "Unknown PreOnline trigger.", 15048);

}

#--------------------------------------------------------------

# End sapnw04 preonline trigger.

#--------------------------------------------------------------

.

.

# give control back to HAD.

if (defined $ARGV[3]) {

‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys

$ARGV[0] -checkpartial $ARGV[3]‘;

exit;

}

‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys

$ARGV[0]‘;

exit;

Step 3: If the preonline file does not exist, copy the sample preonline trigger file
from the %VCS_HOME%\bin\Sample_Triggers directory, in to the
%VCS_HOME%\bin\Triggers directory. Revert back to step 2 to step to make
changes in the preonline file.

A sample_sapnw04preonline file is also available in the
%VCS_HOME%\bin\Sample_Triggers directory. You can copy this file in the
%VCS_HOME%\bin\Triggers directory, rename the file to preonline, anduse this
file.

Step 4: Set the preonline trigger attribute to true for the Service Groups to which
the StandaloneEnqueue server andEnqueueReplication server instances belong.

C:\> hagrp -modify service_group PreOnline 1

For VCS 5.1 and later

C:\> hagrp -modify service_group PreOnline 1 -sys SystemName
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The preonline script is now configured to facilitate Enqueue server behavior. You
can view the logs in the VCS engine log, engine_A.log.

Note:Once the PreOnline trigger is configured, youmay see unexpected behavior
while manually switching or performing online operations on the Enqueue
Replication service group. This behavior is a result of the control logic within the
PreOnline trigger that protects the Enqueue lock table. For system maintenance,
if you prefer to perform manual operations on the service groups, you can do so
by disabling the PreOnline trigger as follows:

C:\> hagrp -modify service_group PreOnline 0

For VCS 5.1 and later

C:\> hagrp -modify service_group PreOnline 0 -sys SystemName
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Troubleshooting the agent
for SAP NetWeaver

This chapter includes the following topics:

■ Using correct software and operating system versions

■ Meeting prerequisites

■ Configuring SAP server resources

■ Checks for an SAP Add-In system

■ Starting the SAP server outside a cluster server

■ Common Problems with Veritas agent for SAP server

■ Reviewing SAP NetWeaver agent log files

■ Using trace level logging

Using correct software andoperating systemversions
Ensure that no issues arise due to incorrect software and operating system
versions. For the correct versions of operating systemand software to be installed
on the resource systems:

Meeting prerequisites
Before installing the Veritas agent for SAP NetWeaver, double check that you
meet the prerequisite requirements. For a list of prerequisites:

See “Before you install the agent for SAP NetWeaver” on page 77.
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Configuring SAP server resources
Beforeusing anSAPserver resource, ensure that you configure the agent attributes
correctly. For more information,

See “Agent attributes for SAP NetWeaver” on page 81.

Checks for an SAP Add-In system
For an SAP Java Add-In instance, you must perform the following checks before
further investigations:

■ The SAP resources running the ABAP and Java Standalone Enqueue server
instances, must be in the same Service Group as the SAP Central instance.

■ The SAP resources running the ABAP and Java Enqueue Replication server
instances, must be in the same Service Group.

■ For the Standalone Enqueue server instances, the value of the InstType
attribute must not be ENQUEUE.

The values must be as follows:

■ For ABAP: AENQUEUE

■ For Java: JENQUEUE

■ For the Enqueue Replication server instances, the value of the InstType
attribute must not be ENQREP.

The values must be as follows:

■ For ABAP: AENQREP

■ For Java: JENQREP

■ Ensure the following:

■ The EnqSrvResName attribute of the ABAP Enqueue Replication server
instance is set to theVCS resource that is running the correspondingABAP
Standalone Enqueue server instance.

■ The EnqSrvResName attribute of the Java Enqueue Replication server
instance is set to the VCS resource that is running the corresponding Java
Standalone Enqueue server instance.

Starting the SAP server outside a cluster server
If you face problemswhileworkingwith a resource, youmust disable the resource
within the cluster framework. A disabled resource is not under the control of the
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cluster framework, and so you can test the SAP server independent of the cluster
framework. Refer to the cluster documentation for information about disabling
a resource.

You can then restart the SAP server outside the cluster framework.

Note: Use the same parameters that the resource attributes define within the
cluster framework while restarting the resource outside the framework.

Followone of these procedures to restart the SAP resource outside the framework.

To restart the SAP instance outside the framework using SAP MMC

1 Log in to the system as a sapsidadm user.

2 Use the SAPMicrosoftManagement Console (MMC) to start the SAP instance.

Ensure that the SAP instance starts successfully. Then attempt to start the
instance inside the cluster framework.

To restart the SAP instance outside the framework from the command prompt

1 Start the SAP Windows service for the SAPSAPSID_xx instance.

2 Use the startsap.exe utility to start the SAP instance:

startsap.exe name=SAPSID nr=InstID

sapdiahost=virtual_hostname

Common Problems with Veritas agent for SAP server
This section describes some problems that you may face while working with the
Veritas Agent for SAP server in a VCS environment.

Unable to install the Veritas Agent for SAP NetWeaver
If you are not able to install the Veritas Agent for SAP NetWeaver, check to see
if previous versions of the agent are present in the system. If present, remove the
older agents and attempt to install the agent again.

Also, ensure that you go through the prerequisites before installing SAP
NetWeaver.

See “Before you install the agent for SAP NetWeaver” on page 77.
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Agent installation terminates with an error
If the installation process terminates with the error "The InstallScript engine on
this machine is older than the version required to run this setup", install the
InstallShield driver 10 or later and begin with the installation process again.

Unable to see an entry in the SAP MMC for an SAP instance
If you cannot see any entry for an SAP instance in the SAP MMC, you must
re-register the SAP services.

To re-register the SAP services

1 At the command prompt, go to the %windir%\SapCluster directory.

2 Run the sapstartsrv.exe command.

3 In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field.

You must re-register the SAP services as described here whenever a change
in the SAP service registration occurs.

The agent for SAP server fails to bring online an SAP instance resource
through VCS

Attempt to start the SAP resource outside the VCS environment to ensure that
the resource is working properly.

See “Starting the SAP server outside a cluster server” on page 102.

You can also view the log files to further diagnose the problem.

See “Reviewing SAP NetWeaver agent log files” on page 108.

Unable to connect: DB connection failed
Ensure that the database is up and running successfully. If the database is not
functional, start the database. If applicable, start the client also. Then attempt to
reconnect.

SAP instance does not come online, and the startsap.exe command
exits with exit code -1

Check the SAP MMC to ensure that the entry for this SAP instance is present. If
the entry is not present, add the SAP instance in the SAP MMC.

See “Unable to see an entry in the SAP MMC for an SAP instance” on page 104.
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Then attempt to bring the SAP instance online.

In case of an Enqueue server failure, the Enqueue server instance fails
to take over the lock table from the Enqueue Replication server instance

If the EnqueueReplication server instance does not recognize the correct Enqueue
server instance, this problem may occur. Ensure that the value of InstID passed
to the Enqueue Replication server process, enrepserver.exe in the start profile,
belongs to the correct Enqueue server instance.

The ensmon.exe command returns exit code 4 for a Enqueue server
instance

If the Enqueue Replication server is not configured or is not online, this problem
occurs. Ensure that if the Enqueue Replication server is configured, the instance
is online.

If theEnqueueReplication server instance is not configured, disable the replication
parameter in the Instance profile of the Enqueue server instance:

enque/server/replication = false

The return code of the ensmon.exe command is 8 for an Enqueue
Replication server instance

The return code indicates that the Enqueue server instance is down. When the
Enqueue server instance fails, the ensmon.exe command returns this code when
the instance is switching over to the Enqueue Replication server instance to take
over the instate lock table.

Check the state of the Enqueue server instance.

Enqueue Replication server does not terminate after enqueue failover
This problem occurs due to a race condition between the Enqueue and the
Replication servers. To resolve the problem,make sure that your enrepserver.exe
is at the following patch level or a level later to it.

7.00: 98

6.40: 171

For more information refer to, SAP Note 1018968
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The Standalone Enqueue server instance does not fail over to the
correct Enqueue Replication server instance

This problemoccurs if the preonline script is not configuredproperly. To configure
the preonline script:

See “Configuring the VCS preonline trigger” on page 96.

This problem also occurs if the InstType attribute is not set properly. Ensure that
the values of this attribute matches correctly.

Table 6-1 shows the values for InstType attribute.

Table 6-1 Values for InstType attribute

Corresponding value of InstType for an
Enqueue Replication server instance

Value of InstType for a Standalone
Enqueue server instance

ENQREPENQUEUE

AENQREPAENQUEUE

JENQREPJENQUEUE

If the Enqueue Replication server instance faults, the instance is failing
over to the node on which the Standalone Enqueue server instance is
online

Whenever an Enqueue Replication server instance faults, it must never fail over
to the node on which the corresponding Standalone Enqueue server instance is
online. This problem occurs if the preonline script is not configured properly to
take care of this failover behavior. To correctly configure the preonline script:

See “Configuring the VCS preonline trigger” on page 96.

This problemmay also occur if the InstType attribute for both the server instances
do not match correctly. Ensure that the values match correctly.

Table 6-2 shows the values for InstType attribute.

Table 6-2 Matching values for InstType attribute

Corresponding value of InstType for a
Standalone Enqueue server instance

Value of InstType for a Enqueue
Replication server instance

ENQUEUEENQREP

AENQUEUEAENQREP

Troubleshooting the agent for SAP NetWeaver
Common Problems with Veritas agent for SAP server

106



Table 6-2 Matching values for InstType attribute (continued)

Corresponding value of InstType for a
Standalone Enqueue server instance

Value of InstType for a Enqueue
Replication server instance

JENQUEUEJENQREP

In case of a resource fault, the Service Group does not fail over
If the resource is not set to critical, the ServiceGroupmaynot fail over. To resolve
the issue, set the resource to critical.

Unable to uninstall an older or current version of the Veritas Agent for
SAP NetWeaver

If you are attempting to uninstall an existing Veritas Agent for SAP NetWeaver,
ensure that you remove all configuredSAP resources, before proceeding to remove
the agent.

See “Removing the VCS agent for SAP NetWeaver” on page 78.

Agent fails to start after installation
Ensure that you have installed Visual Studio 8 redistributable for Visual studio
runtime on your system. Since the agent is compiled with Microsoft.VC80.CRT
version='8.0.50727.762', it fails to start if Visual Studio 8 redistributable is not
installed.

To verify if Visual Studio 8 redistributable is installed, access <system
drive>:\WINDOWS\WinSxS. If a folder similar to
<arch>_Microsoft.VC80.CRT_<random_number>_8.0.50727.762_<random_number>

exists, it confirms that the required redistributable is installed.

For example,

amd64_Microsoft.VC80.CRT_1fc8b3b9a1e18e3b_8.0.50727.762_x-ww_9d1c6ce0

In case if the redistributable is not installed, download the Visual studio
re-distributables forVS2005SP1with versionVC80.CRT_8.0.50727.762 from the
Microsoft site:

For x64 (amd64)

http://www.microsoft.com/downloads/details.aspx?
familyid=EB4EBE2D-33C0-4A47-9DD4-B9A6D7BD44DA&displaylang=en

For IA64 (Intel64)
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http://www.microsoft.com/downloads/details.aspx?
familyid=747AAD7C-5D6B-4432-8186-85DF93DD51A9&displaylang=en

Reviewing SAP NetWeaver agent log files
If you are facing problems while using the Veritas agent for SAP NetWeaver or
an SAP server instance, refer to the following sections to access the relevant files
for information about the issue.

Using SAP instance log files
In case of problems while using the Veritas Agent for SAP NetWeaver, you can
access the SAP instance log files formore information. These log files are located
in the drive:\usr\sap\SAPSID\InstName\work directory.

Using SAP log files
If an SAP server is facing problems, you can access the agent log files to further
diagnose the problem. The log file is drive:\Program Files\VERITAS\Cluster
Server\log\SAPNW04_A.txt.

Using trace level logging
The ResLogLevel attribute controls the level of logging that is written in a VCS
log file for each SAP server resource. You can set this attribute to TRACE, which
enables very detailed and verbose logging.

If you set ResLogLevel to TRACE, a very high volume of messages is produced.
Symantec recommends that you must localize the ResLogLevel attribute for
particular resource only.

Note:Youmay consider to temporarily increase the timeout values for SAPNW04
for debugging purposes. After the debugging process is complete, you can revert
to the original timeout values.

To localize ResLogLevel attribute for a resource

1 Identify the resource for which you want to enable detailed logging.

2 At the commandprompt, localize theResLogLevel attribute for the identified
resource:

hares -local Resource_Name ResLogLevel
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3 Set the ResLogLevel attribute to TRACE for the identified resource:

hares -modify Resource_Name ResLogLevel TRACE -sys SysA

4 Test the identified resource. The operation reproduces the problem that you
are attempting to diagnose.

5 Set the ResLogLevel attribute back to INFO for the identified resource:

hares -modify Resource_Name ResLogLevel INFO -sys SysA

6 Review the contents of the VCS engine output log file.

You can also use the Java GUI to localize the ResLogLevel attribute. Formore
information, refer to the VCS documentation.
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Sample Configurations

This appendix includes the following topics:

■ About the sample configuration for the agent for SAP NetWeaver

■ Sample agent type definition

■ Sample resource configuration

■ Sample sevice group configuration for ABAP and Java architectures

■ Sample service group configuration forAdd-in (ABAP+ Java ) installation type

■ Sample service group configurations for SAP systemonWindows Server 2008

■ Sample service group dependency for SAP NetWeaver

About the sample configuration for the agent for SAP
NetWeaver

The sample configuration depicts the resource types, resources, and resource
dependencieswithin the service group.Review thesedependencies carefully before
configuring the agent for SAP NetWeaver. For more information about these
resource types, see the Veritas Cluster Server Bundled Agents Reference Guide.

Sample agent type definition
The sample agent type definition for SAP NetWeaver is as follows:

type SAPNW04 (

static i18nstr ArgList[] = { SAPSID, SecondLevelMonitor,

EPProgramTimeout, SAPHome, SAPMonHome, SAPHost, ProcMon,

SAPServiceUser, SAPAdminDomain, SAPAdmin, SAPAdminPassword,

AAppendix



ResLogLevel, InstType, InstName, InstProfile, EnqSrvResName,

MonitorProgram }

str SAPSID

int SecondLevelMonitor

int EPProgramTimeout = 10

str SAPHome

str SAPMonHome

str SAPHost

str ProcMon[]

str SAPServiceUser

str SAPAdminDomain

str SAPAdmin

str SAPAdminPassword

str ResLogLevel = INFO

str InstType = CENTRAL

str InstName

str InstProfile

str EnqSrvResName

str MonitorProgram

)

Sample resource configuration
For some values of the InstType attribute, corresponding samplemain.cf files are
as follows.

InstType is equal to ENQUEUE
The sample main.cf file is as follows.

SAPNW04 SAPEC4ASCS_sap

(

Critical = 0

SAPSID = EC4

SecondLevelMonitor = 5

SAPHome = "C:\\usr\\sap\\EC4\\ASCS10\\exe"

SAPMonHome = "C:\\usr\\sap\\EC4\\ASCS10\\exe"

SAPHost = SAPEC4ASCS

ProcMon = { "enserver.exe", "msg_server.exe" }

SAPServiceUser = SAPServiceEC4

SAPAdminDomain = ISV-DOMAIN

SAPAdmin = ec4adm

SAPAdminPassword = IWOuLWlQIoJOkOL
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InstType = AENQUEUE

InstName = ASCS10

InstProfile =

"C:\\usr\\sap\\EC4\\SYS\\profile\\EC4_ASCS10_SAPEC4ASCS"

)

InstType is equal to CENTRAL
The sample main.cf file is as follows.

SAPNW04 SAPEC4CI_sap

(

Critical = 0

SAPSID = EC4

SAPHome = "C:\\usr\\sap\\EC4\\DVBGS12\\exe"

SAPMonHome = "C:\\usr\\sap\\EC4\\sapinfo\\rfcsdk\\bin"

SAPHost = SAPEC4CI

ProcMon = { "disp+work.exe" }

SAPServiceUser = SAPServiceEC4

SAPAdminDomain = ISV-DOMAIN

SAPAdmin = ec4adm

SAPAdminPassword = BPHnEPeJBhCHdHE

InstName = DVBGS12

InstType = CENTRAL

InstProfile = "\\\\SAPEC4ASCS\\sapmnt\\EC4\\SYS\\profile\

\EC4_DVBGS12_SAPEC4CI"

)

InstType is equal to ENQREP
The sample main.cf file is as follows.

SAPNW04 SAPEC4REP_sap

(

Critical = 0

SAPSID = EC4

SecondLevelMonitor = 1

SAPHome = "C:\\usr\\sap\\EC4\\REP11\\exe"

SAPMonHome = "C:\\usr\\sap\\EC4\\REP11\\exe"

SAPHost = SAPEC4REP

ProcMon = { "enrepserver.exe" }

SAPServiceUser = SAPServiceEC4

SAPAdminDomain = ISV-DOMAIN

SAPAdmin = ec4adm
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SAPAdminPassword = HVNtKVkPHnINjNK

InstType = AENQREP

InstName = REP11

InstProfile =

"\\\\SAPEC4ASCS\\sapmnt\\EC4\\SYS\\profile\\EC4_REP11_SAPEC4REP"

EnqSrvResName = SAPEC4ASCS_sap

)

InstType is equal to DIALOG
The sample main.cf file is as follows:

SAPNW04 SAPEC4DI_sap

(

Critical = 0

SAPSID = EC4

SAPHome = "C:\\usr\\sap\\EC4\\D13\\exe"

SAPMonHome = "C:\\usr\\sap\\EC4\\sapinfo\\rfcsdk\\bin"

SAPHost = SAPEC4DI

ProcMon = { "disp+work.exe" }

SAPServiceUser = SAPServiceEC4

SAPAdminDomain = ISV-DOMAIN

SAPAdmin = ec4adm

SAPAdminPassword = BPHnEPeJBhCHdHE

InstName = D13

InstType = DIALOG

InstProfile = "\\\\SAPEC4ASCS\\sapmnt\\EC4\\SYS\

\profile\\EC4_D13_SAPEC4DI"

)

InstType is equal to MDM
The sample main.cf file is as follows:

group SAP_MDIS (

SystemList = { SAPVM21 = 0, SAPVM22 = 1 }

)

IP SAP_MDIS03-IP (

Critical = 0

Address = "10.209.69.191"

SubNetMask = "255.255.252.0"

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"
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)

Lanman SAP_MDIS03-Lanman-sapmdis (

Critical = 0

VirtualName = sapmdis

IPResName = SAP_MDIS03-IP

)

MountV MDIS_MNT (

Critical = 0

MountPath = "C:\\usr\\sap\\MDM\\MDIS03"

VolumeName = MDIS_VOL

VMDGResName = SAP_MDIS_DG

)

NIC SAP_MDIS03-NIC (

Critical = 0

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

SAPNW04 SAP_MDIS03_Res (

Critical = 0

SAPSID = MDM

SAPHome = "c:\\usr\\sap\\MDM\\MDIS03\\exe"

SAPMonHome = "c:\\usr\\sap\\MDM\\MDIS03\\exe"

SAPHost = sapmdis

ProcMon = { "mdis.exe" }

SAPServiceUser = SAPServiceMDM

SAPAdminDomain = isv-domain

SAPAdmin = mdmadm

SAPAdminPassword = gumSjuJogMhmImjMkmL

InstType = MDM

InstName = MDIS03

InstProfile = "C:\\usr\\sap\\MDM\\SYS\\profile\\MDM_MDIS03_sapmdis"

)

VMDg SAP_MDIS_DG (

Critical = 0

DiskGroupName = MDIS_DG

)

SAP_MDIS03-IP requires SAP_MDIS03-NIC
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SAP_MDIS03-Lanman-sapmdis requires SAP_MDIS03-IP

MDIS_MNT requires SAP_MDIS_DG

SAP_MDIS03_Res requires MDIS_MNT

SAP_MDIS03_Res requires SAP_MDIS03-Lanman-sapmdis

// resource dependency tree

//

// group SAP_MDIS

// {

// SAPNW04 SAP_MDIS03_Res

// {

// MountV MDIS_MNT

// {

// VMDg SAP_MDIS_DG

// }

// Lanman SAP_MDIS03-Lanman-sapmdis

// {

// IP SAP_MDIS03-IP

// {

// NIC SAP_MDIS03-NIC

// }

// }

// }

// }

group SAP_MDLS (

SystemList = { SAPVM21 = 0, SAPVM22 = 1 }

)

IP SAP_MDLS05-IP (

Address = "10.209.69.193"

SubNetMask = "255.255.252.0"

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

Lanman SAP_MDLS05-Lanman-sapmdls (

Critical = 0

VirtualName = sapmdls

IPResName = SAP_MDLS05-IP

)
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MountV MDLS_MNT (

MountPath = "C:\\usr\\sap\\MDM\\MDLS05"

VolumeName = MDLS_VOL

VMDGResName = SAP_MDLS_DG

)

NIC SAP_MDLS05-NIC (

Critical = 0

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

SAPNW04 SAP_MDLS_Res (

Critical = 0

SAPSID = MDM

SecondLevelMonitor = 1

SAPHome = "c:\\usr\\sap\\MDM\\MDLS05\\exe"

SAPMonHome = "c:\\usr\\sap\\MDM\\MDLS05\\exe"

SAPHost = sapmdls

ProcMon = { "mdls.exe" }

SAPServiceUser = SAPServiceMDM

SAPAdminDomain = isv-domain

SAPAdmin = mdmadm

SAPAdminPassword = gumSjuJogMhmImjMkmL

ResLogLevel = TRACE

InstType = MDM

InstName = MDLS05

InstProfile = "C:\\usr\\sap\\MDM\\SYS\\profile\\MDM_MDLS05_sapmdls"

)

VMDg SAP_MDLS_DG (

DiskGroupName = MDLS_DG

)

SAP_MDLS05-IP requires SAP_MDLS05-NIC

SAP_MDLS05-Lanman-sapmdls requires SAP_MDLS05-IP

MDLS_MNT requires SAP_MDLS_DG

SAP_MDLS_Res requires MDLS_MNT

SAP_MDLS_Res requires SAP_MDLS05-Lanman-sapmdls

// resource dependency tree
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//

// group SAP_MDLS

// {

// SAPNW04 SAP_MDLS_Res

// {

// MountV MDLS_MNT

// {

// VMDg SAP_MDLS_DG

// }

// Lanman SAP_MDLS05-Lanman-sapmdls

// {

// IP SAP_MDLS05-IP

// {

// NIC SAP_MDLS05-NIC

// }

// }

// }

// }

group SAP_MDS02 (

SystemList = { SAPVM21 = 0, SAPVM22 = 1 }

)

IP SAP_MDS02-IP (

Critical = 0

Address = "10.209.69.190"

SubNetMask = "255.255.252.0"

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

Lanman SAP_MDS02-Lanman-sapmds (

Critical = 0

VirtualName = sapmds

IPResName = SAP_MDS02-IP

)

MountV MDS_MNT (

Critical = 0

MountPath = "C:\\usr\\sap\\MDM\\MDS02"

VolumeName = MDS_VOL

VMDGResName = SAP_MDS_DG
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)

NIC SAP_MDS02-NIC (

Critical = 0

MACAddress @SAPVM21 = "00:50:56:B7:18:36"

MACAddress @SAPVM22 = "00:50:56:B7:21:C3"

)

SAPNW04 SAP_MDS02_Res (

Critical = 0

SAPSID = MDM

SecondLevelMonitor = 1

SAPHome = "c:\\usr\\sap\\MDM\\MDS02\\exe"

SAPMonHome = "c:\\usr\\sap\\MDM\\MDS02\\exe"

SAPHost = sapmds

ProcMon = { "MDS.exe" }

SAPServiceUser = SAPServiceMDM

SAPAdminDomain = isv-domain

SAPAdmin = mdmadm

SAPAdminPassword = gumSjuJogMhmImjMkmL

ResLogLevel = TRACE

InstType = MDM

InstName = MDS02

InstProfile = "C:\\usr\\sap\\MDM\\SYS\\profile\\MDM_MDS02_sapmds"

)

VMDg SAP_MDS_DG (

Critical = 0

DiskGroupName = MDS_DG

ForceImport = 1

)

SAP_MDS02-IP requires SAP_MDS02-NIC

SAP_MDS02-Lanman-sapmds requires SAP_MDS02-IP

MDS_MNT requires SAP_MDS_DG

SAP_MDS02_Res requires MDS_MNT

SAP_MDS02_Res requires SAP_MDS02-Lanman-sapmds

// resource dependency tree

//

// group SAP_MDS02

// {
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// SAPNW04 SAP_MDS02_Res

// {

// MountV MDS_MNT

// {

// VMDg SAP_MDS_DG

// }

// Lanman SAP_MDS02-Lanman-sapmds

// {

// IP SAP_MDS02-IP

//

Sample sevice group configuration for ABAP and Java
architectures

The service group configuration in a cluster depends on some common
characteristics that must be a part of the configuration design.

These characteristics include the following:

■ The SAP Central instance server or the Enqueue server must be dependent on
the database server.

■ EachSAP instance (Central, Dialog, Enqueue, andEnqueueReplication) should
have a separate virtual IP address assigned to facilitate network transparency.

■ EachSAP instance (Central, Dialog, Enqueue andEnqueueReplication) should
be placed on shared disk to facilitate cluster node transparency.

■ Common file systems to include the profile, global and transaction file systems
should bemanaged fromone ormore shared disk objects. These systemsmust
be available to the SAP instance via UNC path with SAPGLOBALHOST.

Figure A-1 shows a sample service group configuration for Enqueue (Central
Service) instance.
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Figure A-1 Service group configuration for Enqueue instance
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Figure A-2 shows a sample service group configuration for Dialog instance
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Figure A-2 Service group configuration for Dialog instance
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Figure A-3 shows a sample service group configuration for Central instance.

Sample Configurations
Sample sevice group configuration for ABAP and Java architectures

122



Figure A-3 Service group configuration for Central instance
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Figure A-4 shows a sample service group configuration for Enqueue Replication
Server instance.
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Figure A-4 Service group configuration for Enqueue Replication Server instance
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Sample service group configuration for Add-in (ABAP
+ Java ) installation type

The characteristics of the configuration design for this installation type are as
follows:

■ TheCentral instance server, and Java andABAPEnqueue Server ServiceGroup
must be globally dependent on the database server Service Group.

■ The Java and ABAP Enqueue servers and the Central instance optionally
configured in one Service Group.
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Note: Symantec recommends to configure the Enqueue Servers and Central
instance in separate service groups.

■ If Enqueue Servers are configured on different service groups, the ABAP and
Java Enqueue Replication servers must be configured in two different service
groups.

■ To facilitate the network transparency,

■ Each SAP server that hosts a Central or Dialog instance must have a
separate virtual IP address.

■ The ABAP and Java Enqueue Server, and the Central instance optionally
have the same Virtual IP address.

Note: Symantec recommends to have two different virtual IPs for Enqueue
Servers and Central instance.

■ TheABAPand JavaEnqueueReplication serversmust havedifferent virtual
IP address, if they are configured in different service groups.

■ To facilitate cluster node transparency, each SAP server that hosts a Central,
Dialog, ABAP Enqueue, Java Enqueue, Java and ABAP Enqueue Replication
instances must be placed on shared disk.

■ Common file systems that include profile, global, and transaction file systems
must be managed from one or more shared disk objects. These systems must
be available to the SAP application through UNC path via SAPGLOBALHOST.

Figure A-5 shows a sample service group configuration for Enqueue (Central
Services) instances for Add-In
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Figure A-5 Enqueue (Central Services) instance for Add-In
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Figure A-6 shows a sample service group configuration for Enqueue Replication
instances for Add-In
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Figure A-6 Enqueue Replication instance for Add-In
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Sample service group configurations for SAP system
on Windows Server 2008

This section provides the sample service group configurations and resource
dependency diagrams for SAP systems on Windows Server 2008.
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Sample configuration for SAP Central Services Instances service group
for Add-In installation Usage Type

This section provides the VCS main.cf for SAP Central Services Instances service
group for Add-In installation Usage Type.

group SAP-PI3SCS (

SystemList = { SysA = 0, SysB = 1 }

)

FileShare SAP-PI3SCS_sapmnt_FS (

PathName = "\\usr\\sap"

ShareName = sapmnt

LanmanResName = SAP-PI3SCS_Lanman

MountResName = SAP-PI3SCS_H_MountV

UserPermissions = { "'SAP_LocalAdmin'" = FULL_CONTROL,

"'Administrators'" = FULL_CONTROL,

"'SYMCORP\\SAP_PI3_GlobalAdmin'" = FULL_CONTROL,

"'SAP_PI3_LocalAdmin'" = FULL_CONTROL }

)

IP SAP-PI3SCS_IP (

Address = "10.209.70.30"

SubNetMask = "255.255.252.0"

MACAddress = "00-15-17-63-45-92"

)

Lanman SAP-PI3SCS_Lanman (

VirtualName = sappi3scs

IPResName = SAP-PI3SCS_IP

)

MountV SAP-PI3ASCS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\ASCS29"

VolumeName = PI3ASCS_vol

VMDGResName = SAP-PI3ASCS_VMDg

)

MountV SAP-PI3SCS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\SCS30"

VolumeName = PI3SCS_vol

VMDGResName = SAP-PI3SCS_VMDg

)

MountV SAP-PI3SCS_I_MountV (

MountPath = "I:"

VolumeName = PI3SCS_I_vol

VMDGResName = SAP-PI3SCS_I_VMDg

)
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MountV SAP-PI3SYS_MountV (

MountPath = "I:\\usr\\sap\\PI3\\SYS"

VolumeName = PI3SYS_vol

VMDGResName = SAP-PI3SYS_VMDg

)

NIC SAP-PI3SCS_NIC (

MACAddress = "00-15-17-63-45-92"

)

SAPNW04 SAP-PI3ASCS_SAPNW04 (

SAPSID = PI3

SAPHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"

SAPMonHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"

SAPHost = sappi3scs

ProcMon = { "msg_server.exe", "enserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQUEUE

InstName = ASCS29

InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_ASCS29_sappi3scs"

)

SAPNW04 SAP-PI3SCS_SAPNW04 (

SAPSID = PI3

SAPHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"

SAPMonHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"

SAPHost = sappi3scs

ProcMon = { "msg_server.exe", "enserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQUEUE

InstName = SCS30

InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_SCS30_sappi3scs"

)

VMDg SAP-PI3SCS_I_VMDg (

DiskGroupName = PI3SCS_I_dg

)

VMDg SAP-PI3ASCS_VMDg (

DiskGroupName = PI3ASCS_dg

)

VMDg SAP-PI3SCS_VMDg (
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DiskGroupName = PI3SCS_dg

)

VMDg SAP-PI3SYS_VMDg (

DiskGroupName = PI3SYS_dg

)

SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_Lanman

SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_I_MountV

SAP-PI3SCS_IP requires SAP-PI3SCS_NIC

SAP-PI3SCS_Lanman requires SAP-PI3SCS_IP

SAP-PI3ASCS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3ASCS_MountV requires SAP-PI3ASCS_VMDg

SAP-PI3SCS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3SCS_MountV requires SAP-PI3SCS_VMDg

SAP-PI3SCS_I_MountV requires SAP-PI3SCS_I_VMDg

SAP-PI3SYS_MountV requires SAP-PI3SCS_I_MountV

SAP-PI3SYS_MountV requires SAP-PI3SYS_VMDg

SAP-PI3ASCS_SAPNW04 requires SAP-PI3SCS_sapmnt_FS

SAP-PI3ASCS_SAPNW04 requires SAP-PI3ASCS_MountV

SAP-PI3ASCS_SAPNW04 requires SAP-PI3SYS_MountV

SAP-PI3SCS_SAPNW04 requires SAP-PI3SCS_sapmnt_FS

SAP-PI3SCS_SAPNW04 requires SAP-PI3SCS_MountV

SAP-PI3SCS_SAPNW04 requires SAP-PI3SYS_MountV

resource dependency tree

group SAP-PI3SCS

{

SAPNW04 SAP-PI3ASCS_SAPNW04

{

FileShare SAP-PI3SCS_sapmnt_FS

{

Lanman SAP-PI3SCS_Lanman

{

IP SAP-PI3SCS_IP

{

NIC SAP-PI3SCS_NIC

}

}

MountV SAP-PI3SCS_I_MountV

{

VMDg SAP-PI3SCS_I_VMDg

}

}
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MountV SAP-PI3ASCS_MountV

{

MountV SAP-PI3SCS_I_MountV

{

VMDg SAP-PI3SCS_I_VMDg

}

VMDg SAP-PI3ASCS_VMDg

}

MountV SAP-PI3SYS_MountV

{

MountV SAP-PI3SCS_I_MountV

{

VMDg SAP-PI3SCS_I_VMDg

}

VMDg SAP-PI3SYS_VMDg

}

}

SAPNW04 SAP-PI3SCS_SAPNW04

{

FileShare SAP-PI3SCS_sapmnt_FS

{

Lanman SAP-PI3SCS_Lanman

{

IP SAP-PI3SCS_IP

{

NIC SAP-PI3SCS_NIC

}

}

MountV SAP-PI3SCS_I_MountV

{

VMDg SAP-PI3SCS_I_VMDg

}

}

MountV SAP-PI3SCS_MountV

{

MountV SAP-PI3SCS_I_MountV

{

VMDg SAP-PI3SCS_I_VMDg

}

VMDg SAP-PI3SCS_VMDg

}

MountV SAP-PI3SYS_MountV

{
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MountV SAP-PI3SCS_I_MountV

{

VMDg SAP-PI3SCS_I_VMDg

}

VMDg SAP-PI3SYS_VMDg

}

}

}

Sample resource dependency for SAP Central Services Instances service
group for Add-In installation usage type

Figure A-7 shows the sample resource dependency diagram for SAP Central
Services Instances service group forAdd-In installationUsageType on aWindows
2008 Server.
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Figure A-7 Sample resource dependency diagram for SAP Central Services
Instances service group for Add-In installation Usage Type on a
Windows 2008 Server
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Sample configuration for SAP Enqueue Replication Server Instances
service group for Add-In installation Usage Type

group SAP-PI3ERS (

SystemList = { SysA = 0, SysB = 1 }

)

IP SAP-PI3ERS_IP (
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Address = "10.209.70.31"

SubNetMask = "255.255.252.0"

MACAddress = "00-15-17-63-45-92"

)

Lanman SAP-PI3ERS_Lanman (

VirtualName = sappi3ers

IPResName = SAP-PI3ERS_IP

)

MountV SAP-PI3AERS_MountV (

MountPath = "C:\\usr\\sap\\PI3\\ERS31"

VolumeName = PI3AERS_vol

VMDGResName = SAP-PI3AERS_VMDg

)

MountV SAP-PI3ERS_MountV (

MountPath = "C:\\usr\\sap\\PI3\\ERS32"

VolumeName = PI3ERS_vol

VMDGResName = SAP-PI3ERS_VMDg

)

NIC SAP-PI3ERS_NIC (

MACAddress = "00-15-17-63-45-92"

)

SAPNW04 SAP-PI3AERS_SAPNW04 (

SAPSID = PI3

SAPHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"

SAPMonHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"

SAPHost = sappi3ers

ProcMon = { "enrepserver.exe" }

SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQREP

InstName = ERS31

InstProfile = "\\\\sappi3scs\\sapmnt\\PI3\\SYS\\

profile\\PI3_ERS31_sappi3ers"

EnqSrvResName = SAP-PI3ASCS_SAPNW04

)

SAPNW04 SAP-PI3ERS_SAPNW04 (

SAPSID = PI3

SAPHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"

SAPMonHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"

SAPHost = sappi3ers

ProcMon = { "enrepserver.exe" }
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SAPServiceUser = SAPServicePI3

SAPAdminDomain = SYMCORP

SAPAdmin = pi3adm

SAPAdminPassword = AFkl41nmqdaou

InstType = ENQREP

InstName = ERS32

InstProfile = "\\\\sappi3scs\\sapmnt\\PI3\\SYS\\

profile\\PI3_ERS32_sappi3ers"

EnqSrvResName = SAP-PI3SCS_SAPNW04

)

VMDg SAP-PI3AERS_VMDg (

DiskGroupName = PI3AERS_dg

)

VMDg SAP-PI3ERS_VMDg (

DiskGroupName = PI3ERS_dg

)

SAP-PI3ERS_IP requires SAP-PI3ERS_NIC

SAP-PI3ERS_Lanman requires SAP-PI3ERS_IP

SAP-PI3AERS_MountV requires SAP-PI3AERS_VMDg

SAP-PI3ERS_MountV requires SAP-PI3ERS_VMDg

SAP-PI3AERS_SAPNW04 requires SAP-PI3AERS_MountV

SAP-PI3AERS_SAPNW04 requires SAP-PI3ERS_Lanman

SAP-PI3ERS_SAPNW04 requires SAP-PI3ERS_MountV

SAP-PI3ERS_SAPNW04 requires SAP-PI3ERS_Lanman

// resource dependency tree

//

// group SAP-PI3ERS

// {

// SAPNW04 SAP-PI3AERS_SAPNW04

// {

// MountV SAP-PI3AERS_MountV

// {

// VMDg SAP-PI3AERS_VMDg

// }

// Lanman SAP-PI3ERS_Lanman

// {

// IP SAP-PI3ERS_IP

// {

// NIC SAP-PI3ERS_NIC

// }

// }

// }
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// SAPNW04 SAP-PI3ERS_SAPNW04

// {

// MountV SAP-PI3ERS_MountV

// {

// VMDg SAP-PI3ERS_VMDg

// }

// Lanman SAP-PI3ERS_Lanman

// {

// IP SAP-PI3ERS_IP

// {

// NIC SAP-PI3ERS_NIC

// }

// }

// }

// }

Sample resource dependency for SAP Enqueue Replication Server
Instances service group for Add-In installation Usage Type

Figure A-8 shows the sample resource group dependency for SAP Enqueue
Replication Server Instances service group for Add-In installation Usage Type.
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Figure A-8 Sample resource group dependency for SAP Enqueue Replication
Server Instances service group for Add-In installation Usage Type
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Sample service groupdependency for SAPNetWeaver
Figure A-9 shows the sample service group dependency for SAP NetWeaver
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Figure A-9 Sample service group dependency
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Changes introduced in Past
releases

This appendix includes the following topics:

■ Changes introduced in the past releases

Changes introduced in the past releases
The changes introduced in the past releases of the agent for SAP NetWeaver are
as follows:

■ Added support for SAP Kernel 7.2

■ Added support for Storage Foundation andHigh Availability Solutions 6.0 for
Windows.

■ Added support for Gateway, Internet Graphics Server (IGS) and Internet
Communication Manager (ICM) processes.

■ Addedsupport forNETBIOSdomainnames (olddomains) forSAPAdminDomain
attribute.

■ Package is modified to install both SAPNW04 and SAPWebAS agents.

■ Added support for Windows Server 2008 (x64)

■ Added support for SFWHA 5.1 SP1

■ Added support for Secure cluster

■ Support for different passwords for SAPServiceUser and SAPAdmin users.

■ Added support for VCS 5.1 on Microsoft Windows Server 2003 (x64) and IA64

■ Added support for Instance IDs 97, 98 and 99
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■ Added support for local system user accounts for SAPAdmin and
SAPServiceUser attributes
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